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1 Get Started 

1.1 Get Started with Filmora 

Wondershare Filmora is a trendy video editing software that empowers you to 

produce creative and polished videos in just a few simple steps. 

 

With Filmora, it becomes easy for you to create any new video project. This guide 

will walk you through the process from importing media files, applying transitions 

or effects, editing audio to exporting the edited videos on Mac. 

 

Note: 

This is the latest user guide for Filmora V11 (for Mac); if you are using versions 9 & 

X, please check the attached PDF guide. 
 

Before you begin: 
 
Prepare your footage/media file: Filmora supports a variety of file formats. You may 
check if your files are supported by Filmora here . Make sure you save your files 
on your computer or a storage drive. 

 

Check the system requirements: Check out the system requirements of Filmora and 

ensure your Mac meets these requirements for the best user experience. 
 

Get started editing 
Once the footage/media files are ready, open Filmora for Mac and get started 

editing. 

Create a new project or open a recent project 

 

❶ To create a new project, choose the aspect ratio of your video and then click New 

Project.  

❷ To open an existing project, click Open Project. 

https://filmora.wondershare.com/tech-spec.html
https://filmora.wondershare.com/tech-spec.html
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Import Media File 

 

Import video footage, audio, or other media files.To import media files, you can: 

❶ Click on the “+" icon to browse the local file on your Mac and add files. 

❷ Drag and drop the media file to the Media Library area. 

❸ Import media files from an external device. 

❹ Import with Instant Cutter tool. 
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Arrange media files on the timeline 

 

To arrange the sequences of your clips or other media files, you can: 

Drag video footages, audio files, images to the Timeline panel and place them in 

the order you wish. 

Apply Transitions and Effects 

Transitions and Effects would help make your video more eye-catching. The 

Transition and Effects panel includes various transitions and effects that you can 

apply. 

 

Add titles 

Filmora has a great number of title templates. You can: 

 

❶ Choose an existing title template under the Titles section, type in your text and 

save. 

❷ Click on the text to customize the text style. You can save it as Custom to use 

later. 

 

Add Titles i Mac 

Edit Color 

Filmora has multiple color editing options. You can: 
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 Enhance the color of your video. 

 Adjust the white balance. 

 Change the tone: Contrast, Saturation, Brightness. 

 Match the color of two different clips. 

 

To edit the color, double click on the clips and click Color to change the 

parameters, and then click Save. If you are seeking advanced editing, you can click 

Advanced. 

Edit Audio 

Filmora is equipped with a complete audio editing solution. You can remove 

background noise, change the audio speed or normalize the audio automatically, 

and more. 

Export 

Export your video to any supported format or post on social platforms directly. 

 

1.2 Keyboard Shortcut Lists 

Keyboard shortcuts allow you to edit videos more quickly. Get familiar with the 

keyboard shortcut lists. 

How to check the list of keyboard shortcuts? 

 

Go to Wondershare Filmora 11 > Keyboard Shortcuts to see a list of all the 

shortcuts. You can search through this list quickly using the search bar at the top 

of the window. 
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Find Keyboard Shortcuts 
How to change keyboard shortcuts? 

You can change any shortcut just by clicking on it and typing in a new one. You 

won't be able to use shortcuts that are already in use. 

 

Search Keyboard Shortcuts 

Filmora supports shortcuts on Shuttle Xpress and Nintendo Joy Con. 
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Full Keyboard Shortcuts List 
 

Module Command Mac Shortcuts 

File New Project Command-N 

File Open Project Command-O 

File Save Project Command-S 

File Save Project As Command-Shift-S 

File Archive Project Command-Shift-A 

File Import Media Files Command-I 

File Record Voiceover Command-R 

File Preferences Command-, 

File Exit (Mac: Quit) Command-Q 

File Undo Command-Z 

File Redo Command-Shift-Z 

File Cut Command-X 

File Copy Command-C 

File Paste Command-V 

Edit Delete Delete 

Edit 
Ripple Delete (Delete and Close 

Gap) 
Shift+Delete 

Edit Select All Command-A 

Edit Copy Effects Command-Option-C 

Edit Paste Effects Command-Option-V 

Edit Show Clip Properties Option-E 

Edit Split Command-B 

Edit Trim Start to Playhead Option-[ 

Edit Trim End to Playhead Option-] 

Edit Crop and Zoom Option-C 

Edit Rotate 90 Clockwise 
Command-Option-Right 

Arrow 

Edit Rotate 90 Counter Clockwise Command-Option-Left Arrow 

Edit Change Speed and Duration Ctrl-R 
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Module Command Mac Shortcuts 

Edit Add Freeze Frame Option-F 

Edit Detach Audio Control-Option-D 

Edit Mute Command-Shift-M 

Edit Stabilization Command-Option-S 

Edit Color Correction Command-Shift-C 

Edit Green Screen Command-Option-G 

Edit Insert Shift-I 

Edit Overwrite Shift-O 

Edit Rename Return 

Edit Delete Delete 

Edit Reveal in Explorer(Finder) Command-Shift-R 

Edit Apply Option-A 

View Play Space 

View Stop Ctrl - / 

View Full screen Option-Enter 

View Previous Frame Left 

View Next Frame Right 

View Previous Edit Point Up 

View Next Edit Point Down 

View Previous Second Shift-Left 

View Next Second Shift-Right 

View Previous Mark Shift-Up 

View Next Edit Point Shift-Down 

View Go to Project Beginning Home 

View Go to Project End End 

View Go to Selected Clip Start Shift-Home 

View Go to Selected Clip End Shift-Endown 

View Zoom in Command+ = 

View Zoom out Command+ - 

View Zoom to Fit timeline Shift-Z 
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Module Command Mac Shortcuts 

View Set In point I 

View Set Out point O 

View Remove in point Alt-I 

View Remove Out point Alt-O 

Marker Add Marker M 

Marker Delete Marker Delete 

Marker Delete Marker Delete 

Marker Edit Marker Shift-M 

Marker Jump to Previous Marker Shift-Up 

Marker Next Marker Shift-Down 

Miscellaneous Help / 

Miscellaneous Export Command-E 
 

1.3 Download/Register/Uninstall 

Find out how to download Filmora on your Mac, register your Filmora, and 

uninstall it here. 

Download & Install Filmora 

If you don't have Filmora yet, click the button below to download it. Choose 

Windows or Mac depending on your OS, and then follow the instructions to finish 

the installation process. 

Install Filmora 

To install Filmora, find the dmg file you just downloaded and open it. Follow the 

onscreen instruction to install Filmora. 

You will find the download dmg files in the Finder. 

Register Filmora 

Log in to your Wondershare ID 

We recommend you to register your Filmora using Wondershare ID. 
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If you don't have a Wondershare ID yet, read this guide to learn how to create a 

Wondershare ID. 

To log into your Wondershare ID: 

❶ Click on New Project on the startup panel. 

❷ On the editing mode windows. Click the “Login” in the upper right corner. 

❸ A login panel will appear. Enter your Wondershare ID and password to log in.  

You will find your Wondershare account and password in the confirmation email 

you receive after the purchase. You can also sign up and log in with Facebook, 

Google+, or Twitter. 

 

How to Register F 

Note: 

You can use Filmora without logging in, but any videos you export will have a 

watermark on them unless you are logged into a Wondershare ID that has a paid 

license associated with it. 
 

Updating Wondershare Filmora 

Go to Wondershare Filmora 11 > Check for Updates, and a window will pop up 

telling you which version you are currently using and whether it is the latest 

version. 

https://support.wondershare.com/how-tos/create-a-wondershare-id.html
https://support.wondershare.com/how-tos/create-a-wondershare-id.html
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You always download the latest version of Filmora for Mac on the product page. 

Installing it will replace the previous version automatically. 

Note: 

If you purchased the perpetual license and upgraded Filmora to a version beyond the 

one you purchased, your license is no longer valid for the new version. 
 

Uninstall Wondershare Filmora 

Go Finder > Applications > Wondershare Filmora and right-click it to choose to 

Move to Trash.m Mac 

 

 

 

1.4 Release Notes 

Find information about recent Filmora updates. 

Wondershare Filmora is a powerful video editing software for creators of all levels. 

We keep our software updated to provide you with the best video-creating 

experience ever. 

Overview 
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Filmora is an intuitive video editor for every skill level, available on Mac and 

Windows. It provides one platform to push your storytelling boundaries and 

features a host of tools that help you quickly create videos efficiently so that you 

can easily tell your stories. 

Latest Version 
The latest/most current version of Filmora is the February release. For more 

information, see below: 

Latest Versions and Features: V11 

What's New Overview 

Purpose 
 
What’s new in the release: 

 FX Plug-ins - Explore amazing visual effects from Boris FX and NewBlue FX. 

 Wondershare Drive - It allows the uploading and sharing of project documents, 

project templates, and exported videos. 

 Speed Ramping - Adjust your video’s speed with better control of your 

keyframes. Easily slow down or speed up your videos to create unique cinematic 

effects. 

 Masking - This interface has been revamped and optimized to support masking 

keyframes. 

 Stock Media - Browse over 10 million stock media files. Explore more with 

royalty-free stock media from Unsplash, Giphy and Pixabay. 

 Auto Synchronization - Automatically align audio and video captured by 

different cameras in the same scene. 

 

Issue Summary 
 Cooperated with Boris and NewBlue, more visual effects are available in Filmora. 

 Wondershare Drive allows the uploading and sharing of project documents, 

project templates, and exported videos, providing the one-click solution to file 

loss and hard-to-find problems. 

 

https://filmora.wondershare.com/video-editor/
https://filmora.wondershare.com/whats-new-in-filmora-video-editor.html
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End-User Impact 
 
 Users' uploading and sharing of project documents, project templates, and 

exported videos are feasible in Wondershare Drive. 

 The function list in the startup window was changed and improved. 

 
System Requirements 
For the latest system requirements, see Tech Specs. 

Contact Us 
For assistance with product usage, sales, registration, and troubleshooting, 

see Contact Us. 

Member Plans 
Find out more about different member plans and get the most suitable one. 

1.5 Member Plans for Filmora 

Filmora has two types of member plans: 

 Annual Plan 

 Perpetual Plan 

Subscribing to one of the above-listed plans allows you to access all the editing 

features(Except AI Portrait) of Filmora and export the videos without a watermark. 

Note: 

The main difference between the annual plan and the perpetual plan is: 

The annual plan provides over 10 updates annually, while the perpetual license 

only provides 1 update. 
 

Member Plans for Effects & Plugins 
Filmora’s effects and plugins have one type of member plan: 

Monthly Plan 

By subscribing to the Filmora Effects & Plugins, you can enjoy the NewBluce FX, 

Boris FX, and AI Portrait features. 

https://filmora.wondershare.com/tech-spec.html
https://support.wondershare.com/en/contact
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Note: 

For the monthly and annual plans, the subscription will automatically. You can 

cancel anytime. 
 

2  New Features of Mac 

2.1 List of all versions on Mac 

February 2022 Release (Version 11). Available on both Windows and Mac OS, 

Filmora 11 has some exciting added features like Speed Ramping, Auto Beat Sync, 

Stock Media and more. 

Currently in Latest Release 
 
Editing 
 

Split Screen: Make photo and video collage, intro and outro, reaction video, 

and comparison in a few clicks. Multiply your fun with multiple screens for a unique 

way to tell your story. 

Motion Tracking: Track the movement of an object in the video, and pin graphics 

and media files to follow the motion. 

Speed Ramping: Adjust your video’s speed with better control of your keyframes to 

create unique cinematic effects. 

Screen Recorder: Filmora screen recorder allows the user to record screen and 

webcam simultaneously, also capture the system and microphone audio. You can 

record games, tutorials, youtube videos, etc., and export the videos to YouTube, 

Vimeo, and devices directly. 

Instant Mode: No editing skill is needed for using an Instant Mode to create a video. 

Just add the media you want to show, and Filmora will make a video for you at 

once. (This feature is only for Windows) 
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Preset Templates: Start with a built-in Filmora video Template to make a creative 

video. You can also save your video templates on the cloud and exchange them 

with other creators! (This feature is only for Windows) 

Effects 

Video Effects: Discover creative transitions, filters, titles, and motion elements 

exclusive to Filmora. 

Green Screen: Reimagine your world by changing backgrounds and creating 

special effects. 

Mask & Blend: Use Filmora masking and blending mode to create a creative video 

clip. Just cover and mix video clips. You can get different video effects. 

Audio 

Audio Ducking: Automatically lower the volume of one track to make another track 

clearer when you're recording voiceovers, narrations, translations, podcasts, 

YouTube videos, and other productions that benefit from lowering background 

music under speech. 

Slience Detaction: Reimagine your world by changing backgrounds and creating 

special effects. 

Audio Synchronization: Use Filmora masking and blending mode to create a 

creative video clip. Just cover and mix video clips. You can get different video 

effects. 

Color 

Color Match: Improve your efficiency of matching color across multiple clips with 

Filmora color match features right now. 

Color Correction: This easy-to-use video editor helps you break the monotony 

even if you have little color correction and color grading experience for videos. 

Previous Releases of Filmora 
 Version History | What's New in Filmora 

 Feature Summary | Filmora 8 

 Feature Summary | Filmora 9 
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 Feature Summary | Filmora 10 

2.2 Latest Versions and Features: V11 

Filmora's spring update to Version 11 is now officially live. V11's big update arrives 

with nine new features to try. New features include NewBlue FX and Boris plugins, 

preset templates, and more. 

It is an unparalleled version that first cooperated with the world-famous 3D Title 

Tool - NewBlue Tilter Pro 7 and transformed from a tool-based product to a SaaS-

based content service co-creation product. 

Note: 

Filmora will push the new features to your PC/Email via the Message Center Check 

for Update. You can also download it directly via our website. 

 

Here's what's new within the new Windows experiences for February 2022: 

Effect Plugins 

V11 is bundled with Hollywood Style NewBlue FX and Boris Continuum Complete

（BCC）effect plugins, including the world-famous 3D Title Tool-NewBlue Tilter Pro 

7. 

Preset Templates 

You could use the template presets to quickly complete the video creation and save 

your projects as templates for reuse. 

Auto Synchronization 

Automatically synchronize audio with video and make it easier to synchronize the 

audio recorded with different devices. 

Stock Media 

With the new integrated Stock Media library, you can get tons of fancy high-

resolution photos, videos, and GIFs or stickers in Filmora, which are all royalty-free. 

Wondershare Drive 
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You can transfer your files（project files, templates, and videos）to a cloud drive, 

use them anytime, anywhere, and share with others. 

Speed Ramping 

Speed Ramping helps you master the time of your clips. Fast-mo or slow-mo is all in 

your control. 

Auto Beat Sync 

Analyze music and automatically generate highlight videos for you. 

Mask 

The masking tool allows you to cover up all parts of a video and create fantastic 

effects. 

Instant Mode 

Instant Mode provides complete video templates. You can quickly get a nice video 

within your media. 

3 Systerm Requirement 

3.1 GPU Rendering and Hardware Encoding 

GPU Acceleration reduces the stress that video editing software applies on the CPU 

and improves the speed and efficiency of the software. 

How to enable GPU Acceleration in Filmora for Mac 

❶ Click Wondershare Filmora 11 > Preference. 

❷ Choose Performance Tab. 

❸ Under GPU section, check the boxes in front of “Enable hardware acceleration 

for video rendering and playback”. 

❹ If you would also like to enable hardware acceleration for video decoding, you 

can also check the box in front of it. 
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3.2 Mac System Requirements 

Check out the basic system requirements for Mac to ensure the best performance of 

Filmora. 

Check the basic Mac system requirements: 

Operating System: macOS V12 (Monterey), macOS v11 (Big Sur), macOS v10.15 

(Catalina), macOS v10.14 (Mojave). 

If you are using OS X 10.7 to 10.13, click here to download the compatible version » 

Processor: Intel i5 or better multicore processor, 2 GHz or above 

(Intel 6th Gen or newer CPU recommended for HD and 4K Videos, also compatible 

with Apple M1 chip). 

Memory: 8 GB RAM (16 GB required for HD and 4K videos). 

Graphics: Intel HD Graphics 5000 or later; NVIDIA GeForce GTX 700 or later; AMD 

Radeon R5 or later. 

2 GB vRAM (4 GB required for HD and 4K videos). 

Disk: At least 10 GB free hard-disk space for installation (SSD-Solid State Disk 

recommended for editing HD and 4K videos). 

Internet: Internet connection is necessary for software registration and access to 

online services like Filmstock. 

https://ssl-download.wondershare.com/video-editor-mac10.7_full718.dmg?_gl=1*1tucpb1*_gcl_aw*R0NMLjE2NDQ1NDU2MDcuQ2owS0NRaUFqSk9RQmhDa0FSSXNBRUtNdE8zVm0xdkdQT2Z6TzB5b3ZfT3ZvX3NsdEttQnhGQ0RMaUVSaTBRNXFGRXFMTHg2ZUN4bGJCc2FBa1owRUFMd193Y0I.&_ga=2.161965052.1168845714.1645409717-743428734.1633683158&_gac=1.194485855.1644545604.Cj0KCQiAjJOQBhCkARIsAEKMtO3Vm1vGPOfzO0yov_Ovo_sltKmBxFCDLiERi0Q5qFEqLLx6eCxlbBsaAkZ0EALw_wcB
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4 Main window 

4.1 Startup Windows 

Learn how to get started with Filmora, the powerful video editing software to 

create your videos with plenty of useful features. 

On the startup panel, you will find the below features. Click on the one you need to 

get started with Filmora for Mac. 

❶ Create Project 

❷ Recent Project 

❸ Project Aspect Ratio 

❹ Tools 

 

Example Startup Window on Mac 
Create Project 

To create a project: 

❶ Choose the aspect ratio from the drop-down menu. 

❷ Click on New Project to enter the editing interface and get started editing. 
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Create a Project on Mac 
Recent Project: 

You can open the recent edited projects on local or Wondershare Drive to continue 

editing. 

 

r Mac – Recent Project 
Aspect Ratio 

Choose your video aspect ratio before getting to editing. 

Tools 

Useful tools to facilitate your video editing process. 

 Screen Recorder: Record your Mac screen to be used for editing. 

 Auto Reframe: Automatically reframe your video for uploading to different 

platforms or for different usage. 

 Instant Cutter: Trim or merge your video clips easily. 
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 AI Stylizer: Stylize your videos with the built-in effects in one click. 

4.2 Panel Layout 

Get to know about the usages of different panels of Wondershare Filmora for Mac. 

Filmora for Mac's Editing Interface 
 
Media Panel 

 Access your media file and other resources like Audio, Transitions, Effects, 

and more. 

Player Panel 

 Preview your video. 

Timeline Panel 

 Arrange your clips sequence and other media files. 

Media Panel 

On this panel, you can access the below resources: 

❶ My Media: Access the media files you imported. 

❷ Stock Media: Browse royalty-free stock media from Giphy/Pixabay/Unsplash. 

❸ Audio: Explore Filmora’s audio file. 

❹ Titles: Find the preset titles to be used in your video. 

❺ Transitions: Make your video eye-catching with various Transitions. 

❻ Effects: Choose the right effects for your video. 

❼ Elements: Add elements like Stickers. 

❽ Split Screen: Splitting screen is never easier with preset templates. 
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Media Panel i 
Player Panel 

The preview panel allows you to preview your editing video. You can: 

❶ Set playback quality. 

❷ Adjust playback quality and display settings. 

❸ Capture a snapshot of the video. 

❹ Mark In. 

❺ Mark Out. 

 

Player Panel in  
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Timeline Panel 

The timeline panel is where you arrange your video clips, audio, transitions, titles, 

effects, elements, and more. 

On the Timeline panel, you can perform various actions for your media files, 

including 

❶ Delete video clips/audio/transitions/elements, etc. 

❷ Split your video clips or audio files. 

❸ Edit your media files’ parameter. 

❹ Render the video for a preview. 

❺ Add marker. 

❻ Record voiceover. 

❼ Mix audio and more. 

 

Example Timeline Panel 

 Basic Editing >  Advanced Editing > Video Track >  Audio Track 

4.3 Touch Bar 

Learn what you can do with Filmora for Mac using Touch Bar. 

Your Mac's touch bar changes depending on what you're doing and provides 

controls to make your work more efficient. Filmora works with your touch bar to 

provide a more intuitive editing experience. 

Touch Bar on Filmora 
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1. Improves your interactions with the software by providing more intuitive 

control options. 

2. Improves editing efficiency by allowing you to make more changes from 

your keyboard. 

What you can do with Touch Bar 

1. Play and insert clips 

 

2. Create a New Project or open a project 

 

3. Import videos 

 

4. Play / Pause your video preview 

 

5. Export video to “Format”/“Device”/“YouTube”/“Vimeo”/“DVD” 

 

6. Cut clips and control the Timeline 
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5 Creating New Projects 

5.1 Create New Project 

A project file will store information about your videos. Learn how to create a new 

project with Filmora for Mac. 

For every project you create, Wondershare Filmora for Mac creates a project file 

(.wfp). This file contains the settings you select for each sequence in the project and 

editing decisions, effects, and music used in the project. 

Filmora project files don't store video, audio, or image files. They store only a 

reference to these types of media files based on the file names and locations. If you 

move, rename, or delete a source file, Filmora won't be able to find it automatically 

the next time you open a project that uses that piece of media. For convenience, 

Filmora offers you the option of archiving your source files with the project. 

Method 1: 

Launch Filmora for Mac and click Create Project > Choose Aspect Ration > New 

Project 

 

Create a new project  
Method 2: 

Launch Filmora for Mac, click File > New > Choose Aspect Ratio 
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Create a n 

 

Note: 

In addition to the above methods, you can also start new projects using Touch 

Bar controls. 
 

5.2 Open Projects 

There are 3 ways to open an existing Filmora project: 

❶ Launch Filmora, click Open Project. 

❷ Launch Filmora, click Recent Project > Click the local video you want to open or 

download the project file from Wondershare Drive. 
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Open Projects  

❸ Click File > Open/Open Recent. 

 

5.3 Move Projects 

Sometimes you may need to edit your project on another computer. To move your 

project, you need to: 

❶ Open the project, click File > Archive Project or use the hotkey 

Shift+Command+A, 
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❷ The project file and the source files will be archived together in the archived .wfp 

file. 

❸ You can now copy or transfer the archived project in .wfp format to another 

computer and continue your editing. Or you can upload the archived project to 

Inclowdz cloud storage and download it on a new computer. 

 

 

Note: 

Please do not just move the saved project to another computer directly. You must 

click File > Archive Project to archive the project first. 

 

5.4 Relocate Projects 

Once you change the location of the source files, rename them, delete them, or 

disconnect the external drive where they are saved, Filmora will not be able to find 

them. Instead, you will be shown windows with the locations the files are missing 

from. 

Relocate missing media files: 

❶ Click Relocate to relocate the missing files; 
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❷ Press OK to reopen the original project; 

❸ If the files have been permanently deleted, you can choose other files as 

replacements. 

 

How to Relocate Pro 

5.5 Best Practices: Cloud Backup 

Cloud backup service is newly released with Filmora V11. It aims to make video-

editing cooperation and sharing easier for video creators. 

How Does Cloud Backup Help with Sharing/Cooperating on Video 
Editing? 

 

❶ It could be troublesome to carry external storage when you need to edit your 

video projects on a new computer or share them with your colleagues. 

❷ With cloud backup, you can upload the file to Wondershare Drive and download 

it anywhere, anytime to continue editing or share the project file with your 

friends/colleagues for them to add their creative thoughts. 

How to Use Cloud Backup? 
 
Upload Project 

Open Filmora > Click Recent Project > Click on the Upload icon on the project you 

would like to backup to Inclowdz Drive > Once completed, you can find the video 

under the Cloud Project tab. 
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How to backup projects to cloud backup 
Share Project 

Under the Cloud Project tab, click the Share icon to share the download link to 

anyone you want. 

Open Project 

Click the Folder icon to open the projects with Filmora. 

Delete Project 

If you wish to delete any projects, click on the dustbin icon to delete them. 

5.6 Media for Use 

Learn about the media files you can use for your videos. 

 Project Media 

Project media refers to the media files you used for your videos, including 

audio, video clips, images. 

 Shared Media 

If you would like to reuse certain media files for future projects, you can 

import them to Shared Media. 

 Sample Colors 

Filmora offers up to 25 sample colors for you to try color editing. 

 Sample Video 

If you don’t have any footage or video clips to start editing, you can use the 

sample videos here. 
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 Sample Green Screen 

Filmora provides 10 sample green screen effects for you to try the Green 

Screen feature. 

 Photo Library 

After you grant access to the Photo Library of your Mac, you can access the 

photo on your Mac under this tab. 

 

 

 Cloud Backup 

Note: 

Paid users will automatically be granted access to 1GB cloud storage. 

6 Importing & Recording 

6.1 Importing 
Wondershare Filmora for Mac enables you to import video shot by any digital 

camera, camcorders, mobile devices, etc., in all major standard and HD video 

formats. Or you can directly record your video from your webcam. A Media Library 

is also provided for you to organize your media clips so that you can easily and 

quickly catch assets for your projects. Find ways to save and share your recorded or 

imported video files after edited here. 

How to import media files: 
There are 4 ways to import media files. 
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❶ Click the “click here to import media” in the center of the Media Library to add 

files directly. 

❷ Go File > Import Media, or My Media > Import and choose one of the below 

sources: 

 Import Media Files: Import a single media file. 

 Import Media Folder: Import a media folder containing more than one media 

file. 

 Import from External Device: Import media files from an external device like a 

USB drive, hard drive, and more. 

 Import with Instant Cutter Tool:  Import trimmed/cut video from Instant Cutter 

Tools. 

❸ Click the Import on the top bar to import the media file. 

❹ Drag and drop to the Media Library directly. 

 
 

6.2 Recording 

Apart from the videos shot by your digital devices, you can also import media files 

by recording video from your webcam, capturing the computer screen, or recording 

a voiceover. 



6 Importing & Recording 

 37 / 170 

Where can I find the Record feature: 
❶ File > Record Media 

❷ Record button under My Media tab. 

How to Record computer screen: 
 

Note: 

You need to grant screen recording access to Filmora before you can use this 

feature. 

 

❶ Click the "Record" option, and choose "Record Screen". 

❷ The built-in Wondershare Screen Recorder will launch. 

❸ Hit the red button to get started. If you want to stop the recording, you can hit 

F9. You can also customize the screen recording setting to record your desired 

videos. 

 

How to record  

Record videos from webcam: 
 

Note: 

You need to grant camera/microphone access to Filmora before you can use 

this feature 

 

❶ Click Record > Record from Webcam. 

❷ In the pop-up Video Recording window, click the red button to start recording 

and click it again to stop recording. 
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❸ Click OK to save the recorded video file. 

 

How to record we 

Record Voiceover 
❶ Click Record > Record Voiceover. 

❷ Hit the Record button, and it leaves you 3 seconds to get ready. 

❸ Hit the record button again to stop recording. 

To get the best result, we recommend you connect a microphone to your Mac. 
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H 

All the recorded media files will be saved into Media Library automatically, and you 

can drag them to the Timeline for editing. 

7 Video Editing on Mac 

7.1 PIP (Picture in Picture) 

Using video overlays enables you to simultaneously display two or more video clips 

on the screen. It is a useful technique for creating online tutorials, product 

demonstrations, and gaming videos. 

Overlay a video to a background video 
❶ The first steps to make a PIP video is, import 2 video clips into Filmora and drag them 

to the timeline. Remember to put the 2 video clips in different tracks. Double click the 

preview window. 

❷ Now you can customize the size and region of the overlay video. Then a list of editing 

options will appear in the left corner. 

 

overlay a video 
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transform rotate video 

Transform 
The first editing option is “Transform”. You’ll see several option under this part, 

including rotate, flip, scale and position. You can select the overlay video to rotate it to a 

customized angel, flip it, scale the size and change the position. 

Compositing 
Click into the Compositing tab and select compositing to blend your main video with 

your PIP clip. You can adjust your opacity depending on how intense or subtle you want 

the effect to be. 

 

video compositing 
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Motion tracking 
The “Motion Tracking” feature is also available in PIP video, check how to apply motion 

tracking to video. 

Stabilization 
Stabilization is used to adjust the smooth level and edge processing of the video, check 

how to use stabilization in Filmora. 

 
 

Apply green screen 
You can also apply green screen effects to picture in picture videos to enhance to a new 

level. The settings includes color, offset, tolerance, edge thickness, edge feature and 

alpha channel. Learn more about using green screen effects. 

Lens correction 
Len correction allows you to select camera profile and resolution, you can also adjust the 

level. Learn how to use lens correction. 
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Drop shadow 
Use the drop shadow includes the distance, blur, opacity, color and direction. Learn how 

to use drop shadow. 

Auto enhance 
Auto enhance allows you to adjust the brightness in the parts of overlay video, learn 

how to use auto enhance. 

7.2 Split Screen 

Split screen is commonly used to depict a scene from multiple angles or to show 
characters placed in different locations having a conversation, the following are 
the steps to use Filmroa to create split screen video on Mac 
 

Choose split screen effects 
❶ Click on the Split Screen tab and start browsing through the collection of Split Screen 

layouts. You can choose from more than thirty layouts that enable you to have as many 

as six different videos playing simultaneously within the screen. 

❷ Choose one of the effects and drag it to the timeline, you’ll see an interface like 

below: 
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split screen effect mac 

 
 

Add video clips to a split screen layout 
Click on a video you’d like to add to it in the Media tab. Repositioning the clip requires 

you to just drag from its default location and drop it to a new location in the preview 

window. 
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Edit a split screen video 
Click on the Video tab that is located next to the Media tab to start editing the split 

screen you created. You can now change the border and size to your desired ones of the 

split screen video. 

 

edit a split screen video 

Scroll down the options and you’ll see the Transform, Stabilization, and Chorma Key 

options. 

  

edit options split screen 

 Transform allows you to rotate, flip, scale the videos, and change the position; 

 Stabilization makes it possible to adjust the smooth level and edge processing; 

 Chroma Key contains color, offset, tolerance, edge thickness, edge feather and 
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alpha channel. 

You can also find the “Lens Correction”, “Drop Shadow” and “Auto Enhance” 

options from this panel. 

 

Lens correction shadow and auto enhance 

7.3 Lens Correction 

Filmora provides a practical feature for editing action cam footage. That is Lens 

Correction! It will help to adjust the lens of the camera in an easy way. Here’s how 

to use it: 

Double click the video from timeline (assuming you’ve already imported), and then 

find “Lens Correction” from the panel. 

 

Lens correction shadow and auto enhance 
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Then you can select the camera model, click the scroll down icon and you’ll see the 

list of available camera models. 

 

Lens correction shadow and auto enhance 

After select the camera model, you can now choose the desired resolution from 4K 

SuperView to 720p Wide. You can adjust the correction level by dragging the Adjust 

Level slide bar. 

 

Lens correction shadow and auto enhance 
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7.4 Split & Cut Videos 

Split a video or cut the unnecessary parts are frequently used editing features. 

Here’s the steps of how to split or trim video in Filmora. 

Split Video 
There are two methods you can use to split video. After you imported the video into 

Filmora, drag the video to the timeline. 

Move red scissor icon on the timeline to the position where you want to split; and 

then right click on it. Now you’ll see the “Split” option, click it. 

 

split video option 

Another way to split video is, select the video from timeline, move the red line to the 

target dot, click the red scissor or the scissor on the top of the timeline. 

start video split 
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Cut video 
Different from split video, “cut video” means cut and remove part of the video. 

Thus, it usually requires to split the video and then cut it. 

First, drag the target video to the timeline, and then split it into 2 or more parts. 

 

cut video mac 

Choose the part(s) you don’t need and right click on it, select “Cut” to remove it. 

 

start video cut 
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7.5 Drop Shadow 

Drop shadow is an effect that is commonly used in photo and video editing. It is 

created by separating the subject object from the background and adding a custom 

shadow. Here are the steps on how to use drop shadow effect in Filmora. 

Double click the video from the timeline once imported, a pop out window will 

appear in the upper left corner. Scroll down and find “Drop Shadow”. 

 

drop shadow panel mac 

Click on the icon near “Drop Shadow” to enable the settings. Then you can adjust 

the Distance, Blur, Opacity. Moreover, you can also change the color and directions. 

 

drop shadow settings 
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You can choose the target color for the shadow by customize the red, green and 

blue color weight. Once everything is done, click “OK” to apply the effect. 

 

drop shadow color 

drop shadow settings 

7.6 Face Off 

Note: 

The difference between the Mosaic effect and the Face-off effect is that with 

the Mosaic effect you will be able to blur a stationary portion of your video 

clip, whereas with Face-off you will be able to cover moving faces. 

 

Here's how. 

Find Utility and Choose Face-off 

Go to Effects in the top menu and type face-off into the search bar, or scroll 

through the effects until you find UTILITY. Then choose Face-off. 
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drop shadow panel mac 

Preview Your Video 

Drag the Face-Off effect onto the clip you want to apply it to in the timeline. Then, 

choose either the blurred effect or one of the replacement images. You can preview 

what your video looks like with the Face-Off effect by clicking the Play button in the 

Preview Window. Click OK when you’re done. 

 

drop shadow settings 
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7.7 Crop and Zoom Videos 

Follow the steps below to crop out and zoom into sections of your video clips on 

Mac with Filmora: 

Select the video from the timeline, click on the “Crop” icon. 

 video option on mac 

A new window will show out to let you adjust the ratio (preset dimensions: 16:9, 4:3, 

1:1 or 9:16) and customize the region. Click “OK” once set. 
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crop video on mac 

To pan and zoom videos, switch to the “Pan and Zoom” function, you’ll see 4 

options in the right corner. 

 

switch pan and zoom on mac 

Zoom in: Using this option you can zoom in from the larger frame to the smaller 

blue frame. This feature can be used to zoom in on a character’s face in the video. 

 

zoom in mac 
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Zoom out: You can also zoom out from the smaller red frame to the larger green 

frame to show a larger screen. 

 

zoom out mac 

Pan right: Move horizontally from the right red frame to the left green frame. To 

move from the right frame to the left to showcase other characters and focus on a 

particular subject. 

 

pan right mac 

Pan left: You can move horizontally from the left red frame to the green frame on 

the right side. This can be done to follow a subject or move among characters. 
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pan left mac 

Swap the start and end areas: You can swap the start and end area instantly just by 

clicking the swap button. 

7.8 Change Speed 

Speed up or slow down a video is commonly used in editing. Here we are going to 

show you how to change video speed in Filmora on Mac. 

Import the video into Filmora, drag it to the timeline and then right click on it, 

choose “Speed and Duration”. 

 

Lens correction shadow and auto enhance 
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Then you’ll see several options, including Speed, Duration, Reverse, Ripple and 

Audio. You can drag the speed bar to change it, the duration will change 

automatically. 

 

Lens correction shadow and auto enhance 

To reverse a video or enable ripple edit, just check the boxes in the front of the 

options. 

7.9 Mask 

If you want to create some effects to present the video in a creative way, add mask 

is a way to go. Here we are going to show how to add different types of mask to a 

video in Filmora on macOS. 

After dragging your video to the timeline, double click it and an editing panel will 

appear. Switch to “Masks” and you’ll see several options, including Rectangle, 

Circle, Double line, Single line, Love, and Star. 
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Lens correction shadow and auto enhance 

Click on one of the masks and you’ll see the editing options, including Invert Mask, 

Blur Strength, Transform, Horizontal and Vertical. You can customize the settings 

and then click “Add”. 

 

Lens correction shadow and auto enhance 

Now you can preview the mask effects by hit the play button. However, if you don’t 

want the effects, just lick “Delete” button. 

7.10 Video Snapshot 

To take a snapshot of a video clip and save it as an image file, just follow the steps 

below: 

 Import the video clip to the Media Library. 

 Select the video in the Media Library so you can see it in the preview window. 

 Play the video and click the snapshot icon at the desired frame. 
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click snapshot mac 

7.11 Play Video in Reverse 

Here’s how you can flip your video to play backwards: Launch the program and 

select Create New Project. Click Import to import your video to Media Library. 

Drag and drop the video into the timeline. Right click on the video clip and select 

Speed and Duration. 

 

speed and duration 

A new window will pop out, check “Reverse Speed” and click “OK” to apply. 
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reverse speed on mac 

7.12 Freeze Frame 

Use the timeline zoom controls to magnify the timelin, so you can easily find the 

frame you'd like to freeze. Then, place the playhead at that location. Click on the 

Speed icon to change video speed and select the Freeze Frame option from the 

drop-down menu. 

 

speed and duration 

Choose the “Freeze Frame” from the timeline, and you’ll see 2 options: “Customize 

Freeze Frame Duration” and “Delete”. 

 

Choose “Customize Freeze Frame Duration” and you’ll see a new window. Now you 

can adjust the settings to meet your requirements. 
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reverse speed on mac 

7.13 Auto Enhance 

If you have a video that is not in good quality, use auto enhance will help improve it. 

Here’s how to auto enhance to improve your videos. 

Double click the video from the timeline once imported, a pop out window will 

appear in the upper left corner. Scroll down and find “Auto Enhance”. 

 

auto enhance settings 

Now you can adjust the amount by dragging the white line, click “OK” once you 

make the perfect video quality. 
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auto enhance amount 

7.14 Mosaic 

Mosaic is a very useful effects in editing videos and images, as it helps to blur the 

face, logo and other sensitive parts. Below are the steps to use mosaic effect in 

Filmora on macOS. 

Import video to Filmora and drag it to the timeline, then open the mosaic effect. 

There are two way to find mosaic, one is, click the “Effects” option and then choose 

“Utility”, you’ll see the “Mosaic” in the list. 

 

mosaic effects 

Another way is easier, just enter “mosaic” in the search bar different types of 

mosaic effects will appear. 
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choose mosaic effect 

Click the mosaic effect, and new settings panel will pop out. It allows you to change 

the mosaic position, angel, type, intensity and opacity in the video. Customize the 

mosaic to your desired status and click “OK”. 

 

 

mosaic settings mac 

Now in the preview window, you’ll see the final result of mosaic. 
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mosaic video 

 

7.15 Borders 

Adding borders is for the Split Screen feature. 

❶ Choose the Split Screen template you would like to use. 

❷ Click the Split Screen and choose the Video tab. 

❸ Enable the Border option to add borders around the clips in your split-screen. 

❹ You can adjust the color and size of the border. 

 

Add Border to Video for Splitting Screen 
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7.16 Transform 

With Filmora for Mac, you can perform the below transform for your video: 

 Rotate 

 Flip 

 Scale 

 Change Position 

 

How to change video orientation and more with Filmora? 
❶ Double click on the video clips you would like to adjust. 

❷ Under Video Tab > Choose Basic > Turn the toggle on before Transform. 

❸ Adjust the setting to achieve the desired outcome. 

❹ Click Ok to save the setting. 

 

Transform Your Video Mac 

7.17 Compositing 
Compositing lets you combine multiple video clips together and make it one. You 

can adjust the Blending Mode and opacity of the target video in Filmora for Mac. 

How to use compositing in Filmora for Mac? 
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❶ Double click the video to be composed. 

❷ Under Video > Click Basic. 

❸ Choose the Blending Mode or adjust the video opacity. 

❹ Click OK to save the changes. 

 
 
 

Note: 

100% of opacity means the video is opaque, while 0% of opacity means the video clip is 

completely transparent. 

 

7.18 Motion Tracking 

Motion Tracking gives you the ability to track moving objects in a video clip and 

then have other objects (text, images, video clips, or elements) follow the same 

movement. 

How to use Motion Tracking in Filmora for Mac: 
❶ Double click on the video you would like to track motion. 

❷ Under Video tab > Choose Basic. 
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❸ Turn the toggle on before Motion Tracking. 

 

 

❹ Place the tracker box over the target area in Preview Player. You can change the 

size and position of the box in the preview window. 

 

Place tracker box in the video clips 

❺ Click Start Tracking 

❻ You can choose the objects(text, images, videos clips, or elements) you would 

like to follow the same movement of the tracked object. 
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Add objects to the tracked object to follow the movement 

❼ Adjust the size and position of the text, image, element, or clip that will follow 

the tracked path. 

7.19 Stabilization 

This feature of Filmora will allow you to smooth out shaky footage. 

How to stabilize a video with Filmora for Mac 

❶ Choose the video clip you would like to stabilize. Double click it. 

❷ Under Video tab > Choose Basic. 

❸ Turn the toggle on before Stabilization. Filmora will start to analyze 

automatically. 

❹ After analysis, you can drag the slider to adjust the smooth level. Edge 

processing determines how Filmora will handle the edges of your stabilized video. 

You can set the edge processing to Reflect, tile, or extend. By default, Filmora will 

reflect the video edge. 

❺ Click OK to save if you are satisfied with the result. 
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7.20 Green Screen (Chroma Key) 

You can use the Green Screen (Chroma Key) tool to make a color range in a video 

clip or image in a higher track on your timeline transparent, so the video clip or 

image underneath it can be seen in place of that color range. You can use this 

feature to change the background of a clip and make it look like you're a superhero 

flying through the sky or an explorer on top of a mountain. 

Green Screen works best if you have a solid colored background to make it 

transparent, preferably a color that the subjects in the video are not also wearing. 

The most popular choice is bright green. Here's how to use the Chroma Key/Green 

Screen tool in Filmora for Mac. 

How to use Green Screen: 
❶ Import your background video and your green screen video into Filmora. 

❷ Drag your background video into video track one and your green screen video 

into video track two (located above video track one). 
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How to use green screen in Filmora for Mac 

❸ Make sure your green screen clip is sitting on top of your background clip. 

Double click on it to open the editing panel. 

❹ Scroll down to find Chroma Key under the video tab and make sure the toggle 

stays on. 

❺ Select a color to make transparent from the Select Color dropdown menu or by 

using the color picker tool to choose the color in the video preview. 

❻ Use the Tolerance, Offset, Edge Thickness, and Edge Feather sliders to adjust 

your transparency (i.e., to change how close to your selected color something has to 

be included). 

❼  You can also check the box next to Alpha Channel to make the editing simpler 

for you. 

 

G 

8 Color Editing on Mac 

8.1 Color Match 

Color Match allows you to color correct clips as a batch to improve efficiency. 

Choose Color Match 
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❶ Move clips and images into the timeline. Color correct one normally. 

❷ Place your playhead over one color-corrected clip and then select multiple other 

clips. 

❸ Click to chooseColor Match. 

 

Color Match 

 

Preview Color Match 
 

Comparison Preview 
 Adjust the degree to which the colors are matched using the slider in the menu 

that opens and see results in the Comparison preview. 

 

Complete Color Match 
 When you adjust to a satisfactory level, click OK to complete the color match. 
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Complete Color Match 

8.2 White Balance 

To mute the audio in a video clip, right-click on the clip in the timeline and choose 

Mute. 

White Balance is used to adjust the color temperature of the video image to 

improve the ambient color of your video effectively. Please follow the below steps 

to adjust it: 

Click White Balance 
❶ Tick the option marked White Balance. 

❷ Drag the Temperature slider forward or backward to make the adjustment directly. 

❸ Drag the Tint slider to adjust the color level of the video directly. 
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Advanced Settings 
Or you can go to the Advanced settings. Find the White Balance to adjust the 

Temperature and Tint. 

8.3 Color Enhancement 
Enhance your video clips by adjusting the color enhancement. 

Double click the target clip in the timeline to enter the Edit panel, and 

select Color menu, the window will show as below: 

 

Color Enhancement 
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You can click Auto or adjust the Threshold and Value to enhance the color of the 

video clip. 

8.4 Tone 

There are different tone controls to adjust the tonal scale of your video clip or 

footage. 

 

Tone Controls 

Contrast 
The contrast will affect the mid-tones of color in the video. The middle-to-dark 

areas will become darker when increasing the contrast. Similarly, decreasing the 

contrast will make the middle-to-light areas lighter. 

Saturation 
Drag the slider to adjust the overall saturation. 

Brightness 
You can adjust the slider until the video looks nice with the desired 

brightness. 
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8.5 3D LUT 

A Look-Up Table (LUT) is a file containing math instructions to replace a color with 

another one. It’s like a color grading preset. 3D LUTs are used extensively in the 

movie production chain, as part of the Digital Intermediate process. To apply the 3D 

LUT, please follow the below steps. 

Apply 3D Lut 
❶ Tick the option marked 3D LUT. 

❷ Choose a template that you like. 

 

3D LUT 

Note: 

If you can not find the one you need in the dropdown list, you can also download 

and install some free 3D LUT beyond Filmora, and then select Load New LUT to 

load them from your local hard drive. 
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9 Audio Editing on Mac 

9.1 Mute The Audio Clip 

To mute the audio in a video clip, right-click on the clip in the timeline and 

choose Mute. 

 

 

9.2 Detect Beat and Create Beat Markers 

Filmora’s Beat Detection function will mark audio beats automatically and make it 

easier to match your video. Here are the steps to use Beat Detection. 

Creating Markers with Beat Detection 

Right-click on a music file that you want to detect the beats for. You can choose 

from the built-in music or your own imported audio files. Select Beat Detection in 

the context menu. A Beat icon will appear on the music’s thumbnail when the 

analysis is finished. 
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Beat Detection 

Note: 

Filmora will need to install the beat detection plugin for the first time you use Beat 

Detection. It may take some time. 

 

To see the beat markers, drag and drop your analyzed music file into your timeline. 

 
 

Beat Options Setting 
Filmora will display highlight beat markers in red every four beats by default, but 

this setting can be changed. You can change the beat detection settings by right-
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clicking the music file in the library. Then select Beat Options. Here you can change 

the highlight beat frequency, highlight offset, or un-check Mark highlight beats 

only to display every beat marker. 

 

Beat Option Setting 

Adding Additional Beat Markers 
Select your audio file in the timeline and place the playhead where you want to add 

a marker. Then, click the marker icon or press M on your keyboard. 

Removing Beat Markers 
Choose a marker and press Delete on the keyboard, or right-click on the marker 

and choose Delete. To remove all markers, choose Delete All Markers. 

Once you’re happy with how the beats are marked, all that’s left is to drag and drop 

photos and videos into the video tracks and arrange them to match the beat. 

9.3 Trim/Split/Cut Out Audio 

Trim Audio Clips 
If you need to trim from the beginning or end of an audio clip, hover your mouse 

over the left or right edge of the clip in your timeline until the trim tool shows. Then, 

click and drag the edge of your clip forwards or backward to trim off the unwanted 

portion. 
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Use the Trim Tool 

Filmora also has an option for you to quick trim from the start or end of a clip. Go to 

the timeline, and place the playhead on the frame you want to trim. Right-click on 

the clip and select Trim Start to Playhead or Trim End to Playhead. You can 

choose what you want to delete, behind the playhead or in front of it. 

 

Trim Start or En 

Split Audio Clips 
Select your audio clip and place the playhead where you want to split it, then right-

click on the clip and select Split or click the Split icon above on the toolbar. 

Split Audio 

 
Cut Out Audio 
If you want to cut out a section in the middle of an audio clip, drag the playhead to 

the start point of the unwanted section and press the scissors icon to split the clip, 
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then drag the playhead to the end of the unwanted section and press the scissors 

again. Now that the unwanted section is on its own, you can select it and press the 

delete icon to remove it. 

 

Cut Out or Remove Audio 

9.4 Audio Mixer 

The Audio Mixer lets you adjust the dB levels of all your tracks that contain audio 

and set whether they're set more to the right or the left. 

To use the Audio Mixer, follow these instructions: 

 Drag and drop all your audio files (including video files from which you will be 

using the audio) into the timeline. 

 Click the Audio Mixer icon in the toolbar. 

 

 

Audio Mixer Icon 

 Drag the small ball along the circle (the Pan/Balance knob) for each track to 

switch the sound between the left and right channels. You can also move the 

circles on the gauges upwards or downwards to adjust the gain. 
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Switch Sound 

 You can choose between Surround and Stereo on the right side of the window. 

You can also drag the corresponding tracks to where you need them along with 

the Pan. 

 

Choose Surround or Stereo 

Note: 

If you select Surround, you'll be able to pan from left to right and from back to front, 

while in the Stereo mode you can only pan from left to right. 
 

 Click OK to apply your changes to your video. 

The Audio Mixer also lets you control the Master volume by dragging the sliders up 

or down so you can choose how loud a video clip should be. Click on the Play 

button to hear the results and click OK to apply your adjustments. 
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9.5 Audio Effects 

There are many sound effects resources in Filmora. You can find them 

in Audio> Sound Effect. 

 

Sound Effect 

9.6 Fade Audio In or Out 

To add fade in or fade out effects to an audio file, you'll first have to place it on the 

timeline. Double-click on it to gain access to the Audio settings panel and then drag 

the fade in and fade out sliders to the right to add fade effects and set their 

durations. 

 

fade in out mac 
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Drag the fade in/out bar to the right and you’ll see the effects from the timeline. 

 

fade in effect mac 

9.7 Pitch 

Audio pitch is another option to adjust your audio file, especially when you want to 

speed up or lower the volume. To change the audio pitch on Mac, just follow the 

steps below: 

After importing audio to the timeline, and you’ll see the audio settings. Navigate to 

the “Pitch” button and drag the slider to the right to set the pitch up. 

 

adjust audio pitch mac 

Then check the timeline and see if it meets your needs, click “OK” to apply the 

adjustments. 
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9.8 Adjust Audio 

To make adjustments to your audio, double click on the audio clip you want to work 

on in the timeline to open a panel with adjustment sliders for volume and pitch. 

 

adjust audio mac 

Now you can see a new panel presents audio settings, including audio fade in, fade 

out, pitch, equalizer, denoise and ducking. 

 

adjust audio settings mac 

For a more advanced audio editing experience, you can also access the Audio 

Equalizer from this panel. You can choose from presets or make manual 

adjustments by clicking ‘Customize’. 

customize equalizer mac 
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Switch to “Speed” option, you can change the audio speed, duration, reverse speed, 

ripple edit and maintain audio pitch. 

 

uniform speed audio mac 

You can also switch to the “Speed Ramping” to select the type you want. Learn 

more about Speed Ramping. 

 

speed ramping mac 

9.9 Detach Audio 

To detach audio from a video in Filmora, just follow the below guide: 

Add the clip to the Timeline and right-click to open the menu and choose the 

Detach Audio option. The proficient tool will automatically detach the audio from 

the video and place it in an audio track on the timeline. 
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detach audio mac 

Now you can easily edit or delete the audio track without affecting the attached 

video clip. 

 

adjust audio settings mac 

9.10 Equalizer 

All videos have an abundance of different sounds like music, speech, or sound 

effects. Changing the strength of sound waves will enable you to mix these sounds 

together into a coherent soundtrack. 

In the audio track, choose “Adjust Audio” to enable the panel. You can find the 

Equalizer, it contains Default, Classic, Rock'n'Roll, Techno, Bass, Sparkle, Hard Rock, 

Pop, Ska, Acoustic, Blues, Folk, Country or Custom. 
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equalizer default settings mac 

Click on the “Customize” button located next to the drop-down menu to adjust the 

Audio Equalizer manually. You can make the adjustments by dragging the sliders up 

or down until you find the desired value for each of them. Hit OK to save your 

settings. 

 

customize equalizer settings mac 
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10 Animation Editing on Mac 

10.1 Preset Animations 

Adding animating effects to video will bring more fun. In Filmora video editor, there 

are many preset animation effects. Just right-click the clip in the timeline, then 

select the Add Animation. 

Drag the preset animations that you like to the video clip. It’s easy and efficient. 

 

Preset Animations 

10.2 Customize Animations 

If you need more animation effects, you can customize the animating effects to your 

video clip. 

 

Customize Animations 
Steps to Customize Animations 
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 Move the indicator to the timestamp where you want to create a keyframe, and 

click Add. 

 Set values in the keyframing menu or drag the media in the preview to adjust 

its size, placement, and rotation for the keyframe. 

 Similarly, add more keyframes, and adjust the rotate, scale, position, and opacity 

values as you like. 

 Playback your video on the timeline and check the animation you create. You 

can also right-click the keyframe on the video clip to edit, delete or clear the 

keyframes that you created. 

 

Note: 

It needs at least two keyframes to create an animation. The first keyframe you make will 

be for the current state of the media you are animating, and then you’ll set a second 

keyframe later in the clip that is changed. 

 

11 Speed Editing on Mac 

11.1 Uniform Speed 

There are two different ways you can change your video or audio speed in Filmora 

for Mac. 

Method 1: Right-click on a clip in the timeline and select Speed and Duration. The 

Custom Speed window will pop up. Drag the speed slider to make your video faster 

or slower. 
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Speed Slider 

Next to the speed slider, you'll see a speed box where you can type in a precise 

speed value. You make your clips up to 100 times faster or 0.01 times slower. 

Method 2: Select your clip in the timeline and click on the Speed Icon in the toolbar. 

Select Custom Speed, Slow, or Fast from the drop-down menu. 

Speed Icon 

11.2 Speed Ramping 

There are 6 preset modes in Filmora Speed Ramping to level up videos. You can 

also customize the speed ramping of videos or audios based on your need. 

Right-click on the clip to Choose Speed> Speed Ramping. Or Click the Speed 

Icon then select Speed Ramping. 

Apply or Customize Speed Ramping 
 Apply the Montage, Hero moment, Bullet time, Jumper, Flash in, or Flash out to 

your video or audio clip. Or you can choose to customize the speed ramping 

settings. 
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Speed Ramping Menu 

 

Maintain Audio Pitch 

Adjust Audio Effect 
 When applying the speed ramping to the audio clip, you can click the Maintain 

Audio Pitch to adjust the audio effect. 
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12 AI Editing on Mac 

12.1 AI Stylizer 

AI Stylizer is a brand new feature of the Filmora 11 video editor for Mac. This 

function can add stylized texture effects to the media file, such as brush painting, 

vintage film, etc. 

Here are the steps to show you how to use AI Stylizer. 

Select AI Stylizer 
❶ Open Filmora 11 and select the AI Stylize. 

 

 

 

 

Import the Media File 
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❷ Drag or import the media file to Filmora. 

Apply the Stylized Effect 

❸ Click to download and apply the stylized effect that you like. 

 

Select the Effects 

 

Preview the Effect 

Preview the Stylized Effect 
❹ Preview the stylized effect. 

Choose SD or HD 
❺ You can choose SD or HD. But the HD might cause lower playback performance and 

cost more exporting time. 
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SD or HD 

Once you are satisfied with the stylized effect, click the Export button to save. 

12.2 AI Portrait 

Add AI Portrait Filters to Videos 
Filmora AI Portrait feature can separate the portrait and background in a video. 

With the help of Artificial Intelligence technology, it can automatically detect the 

portrait in videos and remove the background quickly. You don’t need to use the 

green screen or chroma key anymore. Moreover, you can even add borders, 

glitches, pixelated, and noise effects to make your video stand out. 

Note: 

The AI Portrait filters work best for videos with a single portrait facing the camera 

straight on. Multiple subjects, fast movements, and backlights may affect the result of 

the AI Portrait feature. 

 

How to Add AI Portrait Filters to Videos in Filmora for Mac? 
To apply the AI Portrait filters in Filmora, follow the steps below. 

❶ Drag & Drop Media Files to Timeline 



12 AI Editing on Mac 

 94 / 170 

❷ Add an AI Portrait filter 

Get to the Effects section and click on AI Portrait, then you’ll see nine AI Portrait 

filters there. Click and download the filter that you like. Drag this filter to the 

timeline to apply it. You can also add multiple AI Portrait filters to your video by 

dragging and dropping them to the timeline. 

 

Apply AI Portrait Filter to Video 

The following window will pop up if you are using the free trial version of Filmora 

since these AI Portrait filters are included in the membership benefits. You will have 

two options: click the Buy Now button to upgrade to Pro immediately, or click Try 

It to continue. 

 

Purchase or Try AI Portrait 

Note: 

If you want to export videos with the applied AI Portrait filters, you need to use Filmora 

paid version with effects and plugins. 
 

❸ Adjust the AI Portrait effect 
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After applying the filter, you can also adjust the settings of the AI Portrait effect to 

get better results. Double-click the clip in the timeline and scroll down to Video 

Effects, check the settings of the filter.  

Change Settings for AI Portrait 

❹ Export the video 

Once all the editing is done, click the Export button, and you will see a pop-up 

window as shown below. 

 

Export Window of AI Portrait 

To export videos with the applied AI Portrait filters, you need to pick up a plan of 

Filmora and pay for it. If you don’t want to buy it now, you can also choose to 

directly remove the AI Portrait filters and export the video by clicking Remove and 

Export, or select Re-edit to return to the timeline and remove them manually. 

12.3 Auto Reframe 

Auto Reframe for Different Aspect Ratios 
The Auto Reframe feature can detect a moving object in any video and 

automatically crop it to suit different aspect ratios instantly. What used to take 

hours or even a day of editing can now be done in minutes. If you often need to 
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post your videos to different social media platforms like YouTube, Instagram, and 

Facebook, this feature will improve your video creation efficiency. 

This guide will show you how to use this advanced feature to reframe sequences. 

How to Use the Auto Reframe in Filmora for Mac? 
There are two methods to apply the Auto Reframe feature in Filmora for Mac: 

Method 1: 

Launch Filmora on your Mac device and choose Auto Reframe. 

 

Choose 

Now, drag the clip you want to crop or hit the Import button to select and import it. 
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Import V 

 
Method 2: 

Launch Filmora and select Create Project. Drag the video clip to the Media area, 

right-click and choose Auto Reframe from the pop-up menu. The clip will be 

automatically added to the Auto Reframe tool. 

 

 

After importing the clip to the tool, you can follow the steps below to auto crop it 

for different aspect ratios. 

❶ Step 1: Select the aspect ratio you need, then the reframing will start 

automatically. 
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 There are 5 aspect ratio options: Widescreen (16:9), Instagram (1:1), 

Portrait (9:16), Standard (4:3), and Cinema (21:9). 

 

5 Aspect Ratio Options 

 Once the reframing starts, you can see the result in the preview window. At this 

point, the video outside the frame will be hidden. If you want to see the whole 

video screen, click on the eye icon in the upper right corner. 

 

Choose the Ratios 

❷ Step 2: If you want to adjust the frame, click the Adjust frame toggle button on 

the right, then drag the crop box to adjust it. Fix the frame to fit your needs, and hit 

OK to apply all changes. 



12 AI Editing on Mac 

 99 / 170 

 

Adjust  

❸ Step 3: You can also change the tracking subject and tracking speed by clicking 

on the Advanced tab under Adjust frame. Choose to track the secondary subject or 

adjust the tracking speed. 

 

❹ Step 4: When the adjustment and reframing are completed, hit the Export 

button to save your work. 

If you want to edit the reframed video, keep reading the following steps. 
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❺ Step 5: When the video is created, hit the Upload to Filmora button. The video 

will be automatically imported to the Media window in Filmora. 

 

❻ Step 6: You can drag the clip to the timeline for further editing. Add music, titles, 

effects, or transitions to enhance it. 

 

Edit the Video Aft 

❼ Step 7: When the editing is done, click the Export button to save and share your 

video. 

12.4 AR Stickers 

Add AR Stickers to Videos 
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There are 39 funny AR stickers released with Filmora for Mac to bring you an 

enjoyable video editing experience. With cute and fun elements such as cats, bears, 

pandas, koalas, and much more, these face-tracking stickers can make your face 

more vivid. 

In this guide, you'll learn how to add these cute stickers to your videos. 

❶ Drag and drop the video clip that you want to edit to the timeline. 

❷ Go to the Effects section and click on AR Stickers, then you'll see lots of cute 

stickers there. 

❸ Pick one and double-click it to check its preview window. If you are satisfied with 

the effect, drag and drop it to the video track to apply it. 

 

Apply AR Stickers 

❹ You can repeat the steps above to add multiple AR stickers to your video. 

❺ Once you're done with the editing, click the Export button to save your work. 

Note: 

If you want to export videos with the applied AR stickers, you need to use 

Filmora's paid version. 
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12.5 Auto Audio Ducking 

Audio ducking means lowering the volume of things like background music in order 

for your dialogue to be heard more clearly. Here are the steps about how to apply 

it. 

❶ Select the clip or clips you want to apply audio ducking to (select the clips you 

want to hear more clearly, not the ones you want to lower the volume on).  

❷ Right-click and choose Adjust Audio. 

 

Adjust Audio 

❸ Find the Ducking option and select the lower volume of other clips. A slider will 

appear, which you can use to adjust the volume. 

Adjust Volume 

12.6 Auto Denoise 

Auto Denoise feature can help you remove background noise efficiently. Here are 

the steps to apply it. 
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❶ Select the clip that you want want to remove background noise.  

❷ Right-click and choose Adjust Audio. 

 

Adjust Audio 

❸ Find the Denoise option and select Remove background noise. You can 

choose Weak, Mid, or Strong to adjust the noise volume. 

 

Adjust Noise Level 

12.7 Scene Detection 

The Scene Detection feature can detect the whole video and split them all based 

on different scenes to filter out the best parts and split out those shaking parts, blur 

parts, and so on. 
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❶ After importing the media file, right-click to select Scene Detection as follow. 

 

 

❷ Then in the pop-up window, click Detect. It will detect the whole video 

automatically. Now the video is split into different clips. You then click Add to 

Timeline. 

 

 

❸ Now you can start to pick up those unwanted parts, right-click to delete or click 

the delete box directly to remove them. 
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13 Add Effect 

13.1 Types Of Effects 

There are numerous effects in the Filmora video editor that can help you make 

videos or audios more creatively. 

Numerous effects in Filmora video editor can help you make videos or audios more 

creatively. 

In the Effects tab, there are many types of effects. AI Portrait, AR Stickers, Boris FX, 

NewBlue FX, Luts, Overlays, Filters, etc. You can also find effects based on scenes, 

like Gaming, Social Media, Wedding, and so on. 
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Types of Effects 

13.2 Add And Modify Boris FX Effects 

Boris FX Effects 
 FIlmora supports Continuum, professional-quality effects plugins from award-

winning developer, Boris FX. 

 There are 6 Continuum Units customized for Filmora users, unleashing amazing 

visual effects and graphics potential. 

 Each Continuum unit contains multiple filters with complementary creative 

presets designed by Boris FX. 

 You can browse from the unique effects and thousands of presets. 

 

Boris  

 

Add Boris FX Effects 
 
❶ Drag the clip to the timeline. Then select Effects>Boris FX. There are BCC Art 

Looks, BCC Image Restoration, BCC Lights, BCC Blur, BCC Stylize, BCC Particle, BCC 

PlusLights. You can choose to learn about Boris FX effects by Learn More. 
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Learn about Boris FX Effects 

❷ Then click Download the Boris FX effect plugin. Since the plugin effect package 

is about 400M, it will take time to download the package. Please wait patiently. 

 

Download Boris FX Effects 

❸ After finishing the download process, follow the prompts to complete the 

installation. Then restart Filmora. You will find the Boris FX Effects in the Effects tab. 

❹ Select and preview the effects that you like to apply. 
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Select and Preview Boris FX Effects 
 
 
 
 
 

Note: 

Boris FX Effects is paid add-on for Filmora, click Buy Now or Try It before 

exporting. 
 
 

 

Try or Buy Boris FX Effects 

Modify Boris FX Effects 
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❶ Double click on the Boris FX effects to open the effects setting. Then modify the 

effect and make it look good. 

 

12.3 Add And Modify NewBlue FX Effects 

NewBlue FX Effects 
 5 NewBlue effect collections that have been customized specifically for use in 

Filmora: NewBlue Stylizer, NewBlue Elements, NewBlue Filters, NewBlue 

Essentials, and Titler Pro. 

 Each collection contains a set of factory-installed, professionally designed 

presets. These include 100+ unique effects and 500+ professionally designed 

custom title presets. 

 
 

Add NewBlue FX Effects 
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❶ Drag the clip to the timeline. Then select Effects>NewBlueFX. There are 

NewBlue Stylizer, NewBlue Elements, NewBlue Filters, NewBlue Essentials, and 

Titler Pro. You can choose to learn about NewBlue FX effects by Learn More. 

 

 Effects 

❷ Then click Download the NewBlue FX effect plugin. Since the plugin effect 

package is about 800M, it will take time to download the package. Please wait 

patiently. 

 

 

❸ After finishing the download process, follow the prompts to complete the 

installation. Then restart Filmora. You will find the NewBlue FX Effects in the Effects 

tab. 

❹ Click and preview the effects that you like to apply. 
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Se FX Effects 

Notice: NewBlue FX Effects is paid add-on for Filmora, click Buy Now or Try 

It before exporting. 

 

Try Effect 

Modify NewBlue FX Effects 
❶ Double click on the NewBlue FX effects to open the Effects Then adjust the 

effect and make it look nice. 
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12.4 Add And Customize Filters 

Add Filters 
Filmora offers hundreds of filters to help you create amazing videos. Just follow the 

steps below to figure out how to use it. 

❶ Click the Effects and choose the Default tab. You can see the Filters folder. Then 

select the filter that you like to apply. 

❷ Just drag-and-drop the effect to the timeline or onto the video clip. The filter 

will be used on the whole clip if you drop it onto the video clip. 
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Customize Filters 
You can also change the duration or opacity of filter effects. 

❶ Change the Duration:  

The default length is five seconds, but you can change its duration by dragging the 

edge of the effect in your timeline. 

❷ Change the Alpha Opacity of Filters:  

The alpha opacity (transparency) property has a value of 0-100. The lower the 

number is, the more transparent the filter is. You can double-click on the filter in the 

timeline to customize its opacity. Then in the Preview Window to view the effect. 

 

Customize Filters 
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12.5 Add And Customize Overlays 

Add Overlays 
There are hundreds of overlays to help you create awesome videos. Just follow the 

steps below to learn how to use it. 

❶ Click the Effects and choose the Default tab. You can see the Overlays folder. 

Then select the overlay that you like. 

❷ Drag-and-drop the overlay to the timeline. 

 

Add Overlay 

Customize Overlays 
You can change the duration or opacity of the Overlay effects. 

❶ Change the Duration:  

The default length is five seconds, but you can change its duration by dragging the 

edge of the overlay effect in your timeline. 

❷ Change the Alpha Opacity of Overlays:  

The alpha opacity (transparency) property has a value of 0-100. The lower the 

number is, the more transparent the overlay is. You can double-click on the 

overlay in the timeline to customize its opacity. 
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Customize Overlays 

12.6 Filmstock Assets 

Overview for Filmstock 
Filmstock is a website that offers assets designed for Filmora, including video 

effects, elements, transitions, titles, footages, music, sound effects, and images. 

Visit Filmstock website for more information. 

Key Features of Filmstock 
Over hundreds of effect packs for video creators and updates every month. 

High-quality videos and images from Filmstock to enrich your video editing. 

Thousands of music and audio effects for transitions, gaming, intro, social media, 

movie, birthday, or blockbuster. 

How to Use Filmstock? 
There are 2 methods to help you better use Filmstock. 

Method 1: Download and Use Filmstock Resources from Filmora 

 Open Filmora, choose Filmstock tab 

under Titles, Effects, Transitions, or Elements. 

https://filmstock.wondershare.com/
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 Click and download the assets that you prefer. 

 Drag the assets to the timeline to try it. 

Note: 

Some resources of Filmstock are paid assets for Filmora, you can click Buy 

Now or Try It before exporting 

 

 

T 

Method 2: Download Filmstock Resources from Filmstock Official Website and 

Use in Filmora 

 Login Filmstock with the same account of Filmora. 

 Choose and download the effect packs on Filmstock website. 
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site 

 Find the downloaded Filmstock effect packs under the folder Resource pack in 

Filmora’s Titles, Transitions, Effects, or Elements. 

 

 

 Drag these downloaded Filmstock resources to the timeline. 

 

Note: 

The Filmora effect packs of Filmstock can’t be used if you don’t download 

Filmora. 

 

14 Add Transitions 

14.1 Types of Transitions 
A transition is an effect added between pieces of media to create an animated link 

between them. Transitions can help your movie switch smoothly from one scene to 

the next. 

Filmora provides a list of transitions that you can apply to a sequence. A transition 

can be a subtle crossfade or a stylized effect. You can find them 

under Transitions tab. 



14 Add Transitions 

 118 / 170 

 

 

Filmora offers different types of video transitions to help you create smoother 

videos without noticeable cuts and breaks. 

Some of the most interesting video transitions available in Filmora are: 

 Ripple & Dissolve 

 Speed Blur 

 Warp 

 3D 

 Slideshow 

 Gaming 

 Travel 

 Stylize 

 Plain shapes 

 Wedding & Love 

 Linear 

Each of the above video transition categories includes multiple transition templates. 

For instance, the “Ripple & Dissolve” category has 30+ transition templates. 

Similarly, the “Wedding & Love” category has 19 templates. 

And as you roam around the transitions section, you will find a lot more suitable 

video transitions that would fit your needs. 
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14.2 Add Transition Effects 
Adding transitions to your video helps to improve its flow. You can apply transitions 

to single clips or in between all of the clips on the timeline in Filmora for Mac. 

 Click into the Transitionstab to see the available transitions. Double-click on 

transitions you'd like to preview. 

 Once you find a transition you want to use in your project, drag and drop it to 

the desired location on the timeline. 

 

 Instead of dragging and dropping a transition you can also place the playhead 

at the exact spot on the timeline where you want to add a transition, right-click 

on a transition you want to add, and select Apply. 

 You can also use the Apply to all option if you would like to add the same 

transition to all video clips in your project. To add a random transition to all video 

clips, choose Random to All. 

 To delete a transition, highlight it and click the Delete button in the toolbar 

above Timeline, or press Delete key on the keyboard. 

 If you especially love a transition, you can add it to Favorite by right clicking 

transition in the list and selecting "Add to Favorites" from the menu. 

 

Keep in mind that if you are applying a transition, you need to make sure that 

you've placed a video clip on the timeline. 
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You can add a transition to the start (prefix transition) or the end (postfix transition) 

of any video or image on the timeline, or add transitions between clips. 

14.3 Modify Transitions 
Filmora not only offers many types of transitions, but also the ability to customize 

the properties of the transitions. 

To do that, you can right-click on the transition on the timeline and a small menu 

will pop up. 

 

You can right-click on the transition you've added and select Duration from the 

menu. Change the duration in the pop-up Duration Settings window and 

Click OK to apply the change. 

Alternatively, once you've added a transition to the timeline you can alter its 

duration by dragging one of its edges in the timeline. 

 

The default duration of all Transitions is 2 seconds. To change the default duration, 

select Preferences under the Wondershare Filmora menu and switch to 
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the Editing Tab. Find Transition Duration and enter the new duration. This will 

become the new default duration for all transitions in your project. 

 

You can also change more options of the transition by selecting Show properties. 

In this menu, you can also select a Transition Mode to determine how your 

transition will sit between the clips. You can choose from Overlap, 

Prefix, and Postfix. 
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To apply the same transition through your entire project: 

Right-click on the transition you want to use and select APPLY TO ALL. But note that 

this transition can only be applied for the duration. 

 

Click the OK button to confirm your adjustments. 

15 Add Audio 

15.1 Type of Audio 

Right next to the media lies the “Audio” tab. This is the place where you can find 

numerous audio clips for your videos. 
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You just need to click on the “Audio” tab from the above menu, choose an audio 

category, pick and drag the most suitable audio file to the timeline, and synchronize 

it with the video file. 

FIlmora has a massive audio library, which includes the following categories: 

 Young & Bright 

 Tender & Sentimental 

 Rock 

 Folk 

 Electronic 

 Sound Effects 

 Travel & Vlog 

 Beat Music 

You can also import music from your computer by clicking on the “Music” category 

from the above list menu. 
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15.2 Add and Modify Audio 

There are two ways you can use to add audio to your video: one is to import music 

file from your local computer; the other is to use the music track from Filmora Video 

Editor. 

Import Music from Local Computer 
 
Simply click "Import" button to browse for audio files in your computer. When you 

find the target music or audio file you need, you can select it and import it to the 

Media Library. After that, you can drag and drop the audio into the Audio track in 

the Timeline for further editing. 

Use Built-in Audio from Filmora Video Editor 
 
Click on the "Audio" tab on the top of the menu, select any kind of audio and drag it 

to the soundtrack in the timeline. 

 

Need to modify the audio effect? 
 
Double click on the soundtrack in the timeline to open the sound editing window. 

You can adjust the sound speed, fade in and fade out, volume, and more. And you 

can also remove background noise. 
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16 Add Titles 

16.1 Types of Titles 

Filmora makes it easy to create the titles that match your style. You can even add 

animated text effects like dialog balloons. Captions, lower 3rds, subtitles, openers, 

and end credits are among the text options available in Filmora. 
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With Filmora, adding titles and texts to your videos is not a big deal. 

You can explore the “Titles” tab to see different text templates, such as: 

 Basic text 

 Titles 

 Openers 

 Subtitles 

 Lower Thirds 

 Callout 

 End Credits 

 Social Media 

 Gaming 

 Education and tutorial 

 Travel 

 Sports 

 Business 

 Food 

And many more! 

That means, whether you are making a video for your business, travel blog, social 

media, YouTube music channel, or anything, you can pick a relevant title/text 
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template from the above categories to make your videos more engaging and fun 

for the audience. 

16.2 Add Titles on Mac 

Filmora for Mac makes it easy to create text & titles that match your style. Captions, 

lower 3rds, subtitles, openers, and end credits are among the text options available 

in Filmora for Mac. You can even add animated text effects like dialog balloons. In 

this guide you’ll learn how to access and use them. 

There are a variety of animated text presets you can access under the Titles menu. 

You can customize any text effect you find and save it as a new preset. 

Adding text to your project 
Go to the Titles menu, choose a text effect, and drag it into the timeline. You can 

also right click on the text effect and choose Apply. 

You can also enter plain text, it's no animations or extras, just simple text. 

 

In the Titles menu on the left side of the screen, you’ll see folders for different types 

of text effects marked Opener, Titles, Lower 3rds, Sub Titles, and End Credits. You 

can preview each effect by double-clicking on it. Drag and drop the effect you want 

to use into the timeline, or right click on it and select Apply. 

Applying Openers and End Credits 
To add an Opener (also called an Intro) go to the Opener menu under Titles and 

right click on the Opener you want to add. Select Apply and the Opener will be 

added to a new video track. 
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To add End Credits, go to End Credits under Titles and right click on the credits 

you want. Then, select Apply from the submenu. 

 

 
 

16.3 Edit and Customize Text Effects 

There are a great number of preset text effects, however, to make the text more 

suitable on your video. You can edit and customize the text effect with built-in tools. 

To enter text 
Double click on the text effect in the timeline to open the Text Editing panel and 

type in your message. You can then modify the properties (font, spacing, size, style, 

alignment, color, and more) of the title effect. 
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Click on the Font drop-down menu to change the style of your text. You can also 

download a font from the internet, install it on your OS, and then use it in Filmora. 

Note: If you download a font from the internet you will have to restart Filmora for 

Mac before that font becomes available in the software's font library. 

To apply preset styles to text 
 
Go to the Preset tab of the Text Editing menu and click the thumbnails of the preset 

styles to apply them. 

To change the position of text in the Preview Window 
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You can set a position for your text by changing the Position parameters in Text 

Editing panel. You can also click and drag your text in the preview window to move 

it where you want. 

To adjust the duration of text effects 
 
The default duration of all the text effects is 5 seconds, but you can change that by 

dragging either of a text effect’s edges in the timeline. You can also click on 

the Duration icon to change the effect’s duration. 

 

 

If you want to change the default duration of all title effects in Filmora go to 

the Wondershare Filmora menu, click on Preferences, and then enter the new 

default duration beside Effect Duration. 
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To Apply or Change Text Animations 

In the Text Editing panel click into the Animation tab. Filmora offers more than 80 

different text animations you can apply by double clicking on an effect to preview it 

and then clicking OK to apply it. 

 
 
 

Advanced Title Editing 
Click on the Advanced button in the lower right corner of the Text Editing panel to 

access the Title Inspector window. 



16 Add Titles 

 132 / 170 

 

 

Besides enabling you to add shadows or borders to the text you insert, the Title 

Inspector also lets you add new text boxes by clicking on the Add Textbox icon. In 

addition, you can add shapes like bubbles and arrows by clicking on the Add Shape 

icon or insert an image by clicking on the Add Image icon. Each new element you 

add will be displayed on the timeline below the preview window in Title Inspector 

window. 

Changing the color or opacity, of your text, or adding blur to the text, are also 

options you can access from the Title Inspector window. 

Customizing Text Style 

Besides entering customized text, the Customize tab contains five more 

options: Text Fill, Text Border, Text Shadow, Shape Fill and Shape Border. 

Text and Shape Fill: in Text Fill you can choose from Color Fill, Image Fill or Gradient 

Fill. In Shape Fill, you can choose Color Fill or Gradient Fill. 

 Color Fill: pick a color to fill your text or shape. 

 Image Fill: choose from the built-in images or browse to load your own image 

and have that fill your text. 

 Gradient Fill: set the start and end colors and click an arrow button to set the 

direction. 
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Tip: You can drag the slider below to set the Blur and Opacity (transparency) 

values. 

Border/Shadow: 

Add a border around the letters of your text or a shadow behind them. You can 

drag the Blur slider to blur the text shadow or border or the Opacity slider to adjust 

the transparency. 

Saving Customized Text Effects as Presets 
Filmora for Mac lets you save customized text effects from both the Title 

Inspector and the Text Editing panel. Once you’ve made all the adjustments you 

want to a text effect, click on the Save as preset button located in the lower left 

corner either menu. 

 

A dialogue box will pop up where you can enter the name of the new preset. 

 

 

The new preset will be saved in the Custom folder in the Titles tab. 
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Delete Title 
All title effects in the timeline can be removed by selecting them and pressing 

the Delete key on your keyboard or by clicking on the Delete icon in the toolbar. 

You can also right click on the title effect you want to remove from the timeline and 

select Delete. 

16.4 Animate Text 
Besides adding basic text or applying preset text styles, you can also animate text 

with simple steps. There are 80+ animation presets available in Filmora. 

To Apply Text Animations 
After you add text onto the video on the timeline. You can apply text animation 

through different ways. 

 

Double click the text track on the timeline and the above screen will switch to text 

editor. There are two sub-tabs: Preset and Animation, under the Text tab. 

Switch to the Animation tab in the Text Editing panel, double click on the animation 

you want to try, and watch the Preview window to see what it looks like. 

To customize the animation, you can adjust the options in Transform and 

Compositing panel. Finally, click OK to apply the animation to your title. 

16.5 Text Presets 
When you edit text on the text editing panel, you can find Filmora provides quite a 

lot of preset text styles. You can apply these preset texts onto the video with a few 

clicks. 
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To find preset text, you can double click the text track or right-click on it and 

choose Edit Properties. There lists different text styles on the left of the text editing 

panel. After you choose one, you can still modify the style by adjusting the options 

including fonts, text color, line space, opacity, rotation, scale, etc. 

17 Add Elements 

17.1 Types of Elements 
Elements are motion graphics you can use to decorate your videos. You can add 

motion graphics to your videos to make them look more attractive. To do that, you 

can click the “Elements” tab to check out the entire list of templates. 
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Some of the most popular “Elements” templates are categorized under: 

 Hand Drawn – 21 templates 

 Badges – 12 templates 

 Tutorial – 64 templates 

 Web – 56 templates 

 Pets – 11 templates 

 Shapes – 6 templates 

 Emoji – 9 templates 

 

And there is more to unearth. 

17.2 Add and Customize Elements 
The Elements is one of main important categories for you to create awesome 

videos. You can find this tab on top of the editing window. The Elements tab 

contains a large number of elements which you can easily overlay on your video by 

drag and drop action. 

In this guide, let's learn how to add elements on your videos in Fillmore and how to 

control that element. 
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There are built-in element category which is right inside the installation package of 

the program and downloaded elements which you can get from Filmstocks - An 

online footage library of Wondershare. 

To add an element to your project 
In order to overlay an element on your video, you can click this little plus icon at the 

center of the thumbnail. You can also double click on the thumbnail to preview it 

before adding to your project. 

 
 

To favorite an element 
If you have some common use elements, you can add your elements to this favorite 

folder by hitting the heart icon on the thumbnail. 

 
 

To customize an element 
You can double click on the element box to have more control of the element. 

Fillmora considers an element similar to a video clip, meaning that you can control it 

the same way you can do with a video clip on the timeline. 
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You can transform your clip, select a blending mode and adjust the opacity of the 

clip or apply green screen effect. 

 

If you want there are many creative ways you can do with overlay elements in 

Fillmore, the basic steps are adding an element on top of the video track, adjust its 

size and position on preview window change, the color of the element and add a 

motion for it: it's all up to your creativity, to decide when and how to use it. 

To remove an element from your project 
There are two ways to remove an element from your video: 

 Select the element that you want to remove and hit Delete on your keyboard. 

 Right click on the element in the timeline and select DELETE from the menu. 

18 Exporting Video 
18.1 Workflow and Overview for Exporting 
The Workflow of Exporting 
You will export the video when you finish editing. Here is the workflow of exporting. 

 At first, find the Export button on Filmora and click it. 
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 You will see Five options for exporting. They are Create Video, Export to Device, 

Upload to Youtube, Upload to Vimeo, and Burn DVD. 

 

 

 

 If you are not sure which to choose, just select the first one “Create video”. You 

will see the whole options for exporting. 

 Choose the one way you want to export and click the “Export” button. You will 

see your video in the specified position. 
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The Overview of Exporting 

Filmora provides Five ways to export your videos. Here is the introduction for the 

five ways. 

 Export to Local 

You can export your project file and video to the local computer. It supports to 

export as MP4, WMV, HEVC, AVY, MOV, F4V, MKV, TS, 3GP, MPEG-2, WEBM, GIF, 

MP3. 

 Export to Device 

You can export your video to the device you want, including iPhone, iPad, Apple TV, 

Apple TV 4K, iPod, Samsung Galaxy, Smart Phone, Android Generic, Google Pixel, 

Xbox one, PlayStation 4, PSP,Smart TV. 

 Upload to YouTube 

Filmora supports to export your video to Youtube directly. All you need to do is 

logging your Youtube account and exporting. 

 Upload to Vimeo 

Filmora supports to export your video to Vimeo directly. All you need to do is 

logging your Vimeo account and exporting. 

 Burn DVD 
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You can burn your video from a DVD. Choose the DVD tab and enter the required 

settings, such as the aspect ratio and disc type. 

18.2 Export Video to Local Computer 
Here is how to export and share your finished videos: 

To export your video to your computer, click the export button and choose 

the Local tab. Then, select the format you want to export in. Currently, Filmora 

supports the following formats: WMV, MP4, AVI, MOV, F4V, MKV, TS, 3GP, MPEG-2, 

WEBM, GIF, and MP3. 

 

 

After selecting the output format, you can rename the video and change the 

location on your computer where you save it. You can also check the output 

resolution, frame rate, size, and duration before you export. To change your export 

settings (i.e. resolution, bit rate, and frame rate) click the SETTINGS button. 

In the Settings window, there are three quality levels: Best, Better, and Good. The 

only difference between them is the Bit Rate. You are able to adjust this or other 

parameters, such as Resolution, and Frame Rate in this window. 
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It is best to export your video with the same settings as your original video. 

When you’re finished adjusting your export settings, press OK to save them. Then, 

after you have closed the Settings window, press the Export button in the Export 

window. 

Note: 

The size of the video depends on the length of the project and the bit rate. If the 

file size looks too big, you can try changing the bit rate in the Settings window to 

make it smaller. 
 

18.3 Export Video to Different Device 
Here is how to export and share your finished videos: 

In the Device tab under Format, you can choose to output your video according to 

the ideal settings for different types of devices, such as iPhones, iPads, Apple TVs, 

Samsung Galaxy phones, PlayStation 4s, and more. You can make manual 

adjustments to your settings as well by clicking the Settings button. Click export 

when you’re finished. 
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Note: 

exporting in this way won't automatically transfer your videos to your devices. 

Your videos will still be stored on your computer’s local hard drive. 

 

 

 

 

18.4 Upload Video to YouTube 
Here is how to export and share your finished videos: 

To upload a finished video directly to YouTube, click Export and then select 

YouTube. Input the title, description, and tags for the video and choose whether to 

upload the video as public, unlisted, or private. You will also need to sign in to your 

YouTube account. 
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18.5 Export Video to Vimeo 
Here is how to export and share your finished videos: 

To upload a finished video directly to Vimeo, click Export and then select Vimeo. 

Input the title, description, and tags for the video and choose whether to upload the 

video as public, unlisted, or private. You will also need to sign in to your Vimeo 

account. 

 

18.6 Burn to DVD 
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Here is how to export and share your finished videos: 

You can burn your video from a DVD. Choose the DVD tab and enter the required 

settings, such as the aspect ratio and disc type. 

 

 

19 Wondershare Drive 

19.1 What is Wondershare Drive 
Wondershare Drive is a cloud storage for work and content creators. You can safely 

store and share photos, videos, files and other contents without the device 

limitation. 

The most important is you can upload the project in Filmora to the Wondershare 

Drive to enable you to edit videos anywhere. 

You can manage files in Wondershare Drive in Filmora or by visiting https://drive-

web.wondershare.com/. 

https://drive-web.wondershare.com/
https://drive-web.wondershare.com/
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In this page, you can also upload files. Besides, you can make basic management 

inside the drive including moving, renaming, deleting, downloading files. Even you 

can star the important files. 

19.2 Get 1GB Cloud Storage for Free 
2 Steps to get 1GB cloud storage freely. 

 Download and open Filmora. 

 Click “Cloud Project” and then log into your account to activate the cloud. 
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Now, you can get 1GB for free and start to use the drive. 

Note: 
You can get 1 GB for free after activating Filmora account. 

 

19.3 Use Wondershare Drive 
In Filmora, you can get 1GB cloud storage for free to upload, save, download and 

share your videos and project files.  

You can use Wondershare Drive in Filmora software or through a web browser. 

Using Wondershare Drive in Filmora 
It's easy to save and upload project files to Wondershare Drive. When you launch 

Filmora, choose Recent Project and you can see all local projects, you can click the 

cloud icon to upload and save local project. 

 
 
Using Wondershare Drive through a web browser 
You can also use Wondershare Drive by visiting https://drive-

web.wondershare.com/. To save your video and project files, click Upload button 

and choose the files in the local computer. 

https://drive-web.wondershare.com/
https://drive-web.wondershare.com/
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19.4 Find Files in Wondershare Drive 
There are 2 methods to find your cloud files. 

 Find cloud files in the Cloud Project. 

 

 

 

 Find cloud files in Media>Project Template>Custom 
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Note: 
You can get 1 GB for free after activating Filmora account. 

 

 

 

19.5 Manage Wondershare Drive 
Click “Cloud Project”, you can check your cloud project files, which includes sharing, 

deleting and reveling in explorer. 

 

 

Or you can just click the “cloud” icon on the top to manage your cloud files. Besides, 

you can see the expired date and the storage of Wondershare Drive. 
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19.6 Share files with Wondershare Drive 
With Wondershare Drive, you can easily share you videos and project files to others. 

People can see your sharing videos and edit with your project files. 

Note: 
The sharing project files are only supported to edit in Filmora. 

 

There are 2 ways for you to share your video and project files in Filmora. 

 Switch to “Recent Project” tab and choose Cloud Project, choose the project 

you want to share, and then click the share icon. 
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 Or you can just click “cloud” icon on the top and click the share icon. 

 

 

You can share your files with or without passwords. The validity period is about 1,7 

and 30 days. 

 If share with passwords, you can set the passwords you want. Filmora supports 

4 letters or numbers as passwords. 

 If share without passwords, all you need to do is choose the validity period. 

 

 

 

After setting the sharing options, you can create link for sharing. 

Click “Copy” to quickly copy the link and share it with others! 
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People can open the link and see what you share. 

 

20 Improvement & Troubleshoot 

20.1 Project Settings 
When you click the New Project button on the welcome screen, you will be taken to 

this screen, which is Filmora’s default interface. 

If you forgot to set the aspect ratio from the welcome screen, or if you wanted to 

use a different aspect than the defaults. You can do so by choosing "Project 

Settings" from the File menu. 



20 Improvement & Troubleshoot 

 153 / 170 

 

 

Now, you can pick the correct aspect ratio, resolution, and frame rate from the 

Project Settings window. To use a custom aspect ratio, what you have to do is to 

change the resolution. 

 

For example, if you are making an Instagram video, change the resolution to 1080 

by 1350 and Filmora will automatically set aspect ratio for you. You can lock the 

aspect ratio by clicking on this lock icon here. 

The video aspect ratio is the video width in proportion to the height. This ratio 

describes how wide your video is. 

For example, a video with a 16:9 aspect ratio would not be 16 px wide and 9 px tall. 

You wouldn’t be able to see a video that small. One resolution that has an aspect 

ratio of 16:9 is 1920 px by 1080 px. 

The resolution of our project is measured in how many pixels wide and how many 

pixels tall the video is. By default, Filmora projects will start with the resolution of 
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1920 pixels wide by 1080 pixels high. Since this is the standard scale of full HD 

video, we can freely change the resolution by modifying the number on each box. 

The frame rate is the number of frames a video will show within a second. Many 

digital video cameras shoot at 23.976 and 29.97 frames per second. These are the 

standards in countries that use the NTSC system. 

The 25 and 50 frames/second are used by the cameras in countries that use the PAL 

system. Most movies work in 24 frames/sec. 

Some TV shows and home cameras work in 30 frames per second which reflects a 

realistic motion similar to what we are used to seeing in real life. 

Anything higher than 30 frames per second is mainly used to create slow motion. 

Though some people primarily gamers tend to work with higher frame rates like 60 

frames per second. 

If you are making videos to post on social media like YouTube, most frame rates 

should work fine. But it is ideal to match the settings of whatever footage your 

camera took. By default, FilmoraPro will ask you if you want to match the settings of 

your footage when you drag the first clip into the editor from the media panel. 

 

20.2 Working with Proxy 
Once all the video clips you’d like to use in your next video are transferred from the 

camera to a computer and organized properly, you can start thinking about the 

most efficient way of piecing them together. 

That’s where the creation of proxy files comes in, as you don’t have to work with 

the original size RAW files. Instead, you can create proxies that are significantly 

smaller than the video files your camera has captured and still export the video in 

the 4K or UHD resolution. 

This is a simple and yet very effective video editing technique that makes the video 

editing process much smoother since it will shorten the amount of time your 

computer needs to render previews or perform any other video editing task. 
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What is Proxy Video Editing and How Does a Proxy Work? 
Proxy video editing is a great option if the computer you’re using for editing has a 

modest amount of RAM or if its processor is not powerful enough to support the 

demanding tasks of applying complex visual effects. 

Even though proxy files can shorten the amount of time you need to spend in the 

editing room, this video editing technique is only useful in a particular context. So 

what are the benefits of proxy video editing, exactly? 

When Should You Use Proxy Video Editing? 
Whether or not you can benefit from using proxy files during the video editing 

process depends on how powerful the computer you are using to edit videos is. 

If you have a laptop or a desktop computer that meets all of the video editor’s 

advanced technical specifications, then creating proxy files won’t boost the 

software’s performance significantly. 

However, if you are editing on a device that is primarily designed for web browsing 

or an older model of a PC or a Mac computer, then reducing the resolution of the 

files you use in your projects can save you some time or even prevent the software 

from crashing at a crucial moment. 

 

 
How to Create and Use Proxy in Filmora 
Video content creators who often shoot their videos with action cameras and other 

devices that can record video in 4K resolution can easily create proxy files in 

Filmora. 
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So, once you’ve installed Filmora on your Mac or PC computer, you should just 

double click on its desktop icon and after the app’s welcome window pops up on 

the screen, you should just click on the New Project option. 

Head over to the File menu, when the new project opens and locate 

the Preferences option. Alternatively, you can use the CTRL+SHIFT+, keyboard 

shortcut to bring up the Preferences window and then click on the Performance 

tab. 

 

Make sure that the Enable GPU Acceleration option is activated by clicking on the 

appropriate checkbox and proceed to select your computer’s graphics card from 

the drop-down menu. Click on the checkbox that is located next to 

the Automatically create proxies when media resolution is higher than: option in 

the Proxy menu, and then pick either 1280x720p or 1920x1080p resolution. You 

can also choose a folder on your computer’s hard drive where all proxy media files 

are going to be saved by clicking on the Browse button in the Proxy 

Location submenu. 

In case you want to delete all proxy files you created after you’ve completed a 

project, you can enable the Automatically delete proxies when a project is 

closed option and then click on the OK button to confirm the changes. 

Go to the Media Panel to start importing media files you’d like to use in your 

project and Filmora will automatically create proxies for each file that has a 

resolution that is higher than the resolution you’ve specified earlier. 
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Keep in mind that the amount of time Filmora is going to need to create proxy files 

depends on the size of source files and the number of files you are transcoding at 

the same time. 

20.3 System Compatibility Detection 
In order for Filmora to run properly it must be installed on a system which meets or 

exceeds the following requirements. 

Filmora for Mac System Requirements 
 Operating System: macOS V12 (Monterey), macOS v11 (Big Sur), macOS v10.15 

(Catalina), macOS v10.14 (Mojave). 

If you are using OS X 10.7 to 10.13, click here to get the compatible version » 

 Processor: Intel i5 or better multicore processor, 2 GHz or above 

(Intel 6th Gen or newer CPU recommended for HD and 4K Videos, also 

compatible with Apple M1 chip). 

 Memory: 8 GB RAM (16 GB required for HD and 4K videos). 

 Graphics: Intel HD Graphics 5000 or later; NVIDIA GeForce GTX 700 or later; 

AMD Radeon R5 or later. 

2 GB vRAM (4 GB required for HD and 4K videos). 

 Disk: At least 10 GB free hard-disk space for installation (SSD-Solid State Disk 

recommended for editing HD and 4K videos). 

 Internet: Internet connection is necessary for software registration and access 

to online services like Filmstock. 

 

Tech Specifications of Filmora for Mac 

Supported Input Formats 
 

Type Container formats 

Video 

Formats 

MPEG-1/2 Video file: (.mpg, .mpeg, .m1v, .m2v) 

MPEG-4 Video file: (.mp4, .m4v, .3gp, .3g2, .3gp2) 

QuickTime Movie File: (.mov encoded with MPEG 4 or MJPEG codec 

only) 

Camcorder File: (.dv, .mod, .tod, .mts, .m2ts, .m2t) 

Flash Video: (.flv, .f4v) 

https://ssl-download.wondershare.com/video-editor-mac10.7_full718.dmg?_ga=2.245543558.365534635.1561949463-1790755618.1558429621
https://filmstock.wondershare.com/?fs_channel=ws&utm_source=filmorasite&utm_medium=tech
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Type Container formats 

Audio Visual Interleave (.avi) 

Matroska Video File: (.mkv encoded with MPEG 4 or MJPEG codec 

only) 

HTML5 Video File: (.mp4, .webm,. ogv) 

Non-encrypted DVD Titles: (.vob, .vro) 

Audio 

Formats 
.mp3, .m4a, .wav, .wma, .ogg, .flac, .aif, .aiff, .caf, .au 

Photo 

Formats 
.jpg, .png, .bmp, .gif, .tif, .tiff 

 

Supported Output Formats 
 

Type Container formats or Device/SNS profiles 

Format 

Common 

video/audio 

.mov, .mp4, .m4v, .mkv, .avi, .f4v, .ts, .mpg, .3gp, 

ProRes, .m4a, .mp3, .gif 

4K .mov, .mp4, .m4v, .mkv, 

Devices 
iPhone, iPad, Apple TV, Apple TV 4K, iPods, Apple Generic, 

Android Generic, PlayStation, PSP 

Social Network YouTube, Vimeo 

DVD DVD disc, DVD folder, ISO disc image file 

* Some of the above codec formats may need to be supported by system. 

Supported Effects & Plug-ins 
 

Effects & Plug-ins 

Filmstock Standard 

NewBlue FX (Not available on Mac with M1 chip) 

Boris FX (Not available on macOS v10.14 and Mac with M1 chip) 

AI Portrait 

 

20.4 Render Preview Files 
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This lesson of our Filmora tutorial is dedicated to the Render Button that will ensure 

the smooth playback of video files and visual effects, you add to the timeline. 

Rendering Previews from Filmora’s Timeline 
The playback of high-resolution video files can lag sometimes if the computer used 

for editing those files doesn’t have enough processing power. Lagging can occur 

regardless of the video editing software you are using, but Filmora offers a quick 

way to fix this issue. 

The rendering process can be described as a process during which a computer 

processes information from a particular data source and creates a preview image 

that is displayed in the software’s preview window. 

After you add new media files to the Filmora’s timeline, a red line will appear over 

the portion of the timeline these media files occupy indicating that the footage 

hasn’t been rendered yet. 

 

Your computer will generate rendered versions of the files you placed on the 

timeline after you click on the Render Preview button that is located in the upper 

left corner of the Filmora’s timeline. 

The Render Progress bar will pop up on the screen, informing you about how much 

time remains until the rendering process is completed. 

Keep in mind that rendering process can take a while if you are working with a lot 

of different high-resolution files. 
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The rendering process will eliminate the lagging effect that commonly occurs when 

multiple visual effects are applied to the footage. Once the rendering process is 

completed, the red line displayed over the media files will turn green. 

Under its default settings, Filmora doesn’t automatically render all files you add to 

the timeline, so all video clips or visual effects you placed on the timeline after the 

rendering process is completed have to be rendered separately. The red line is 

going to be displayed over all unrendered media files on the timeline. 

 

Besides clicking on the Render Preview button, you can also hit Enter button on 

your keyboard to start a new rendering session. Rendering all media files added to 

timeline will make the workflow smoother and faster. 

Adjusting the Render Preview Settings 
You can set different render preview settings for each new project separately. 

Simply click on the Preferences option in the File menu and once the Preferences 

window pops up on the screen head over to the Performance menu. 
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Under the Preview Render menu, you can enable the Background render option 

which will perform the rendering automatically after you add a new media file to the 

timeline. You can set up how long it takes for the automatic background rendering 

start by setting the amount of time. However, enabling Background Render can 

slow down the Filmora video editor if your computer doesn’t have a lot of 

processing power. 

So, if you are editing a video on a computer with limited processing capabilities, you 

should leave the background render box unchecked. Filmora lets you set the 

destination folder for all preview renders you generate while working on a certain 

project. 

Click on the Browse next to the Preview Render file folder and proceed to select the 

destination on your hard drive where all preview renders are going to be kept. 

In case you don’t want to keep the files you render after you close Filmora, you 

should enable the Automatically delete render files option when closing a project 

option. However, deleting render files is only advisable if you no longer need them, 

since going through the rendering process repeatedly can take a lot of time. 
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Instead, you can just click on the Clean button after you completed a project and 

delete all preview render files from the destination folder. 

20.5 Manage Timeline 
The timeline is where the majority of the video editing process takes place. So, in 

this tutorial, we are going to learn how to add, adjust, lock and hide video and audio 

tracks in Filmora timeline panel. 

Using the timeline 

The Playhead is an indicator that shows you where on the timeline you are currently 

located and allows you to move through the media files you placed on the timeline. 

The frame at which the Playhead is positioned is going to be displayed in the 

Preview window. 

 
 

Adjust timeline view 

 

As you hover over the area of the timeline that shows time with your mouse, the 
pointer is going to change into a two-way arrow. Move the mouse either to the 
left or the to the right while holding the left-click to zoom in or to zoom out of the 
timeline. 

 

 

The Zoom to Fit the Timeline icon is located in the upper right corner of the 

timeline. Clicking on this icon will enable you to see all the media you’ve added to 

the timeline within a screen. Alternatively, you can use the zoom slider if you want 

to adjust the zoom level manually. 
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Managing Tracks 
A track is the part of the timeline where all the media is located. Tracks in Filmora 

can either hold video or audio files, and you should keep in mind that audio and 

video clips can never be on the same track. 

Add One Track Each Time 
In order to create and add a new track you just have to drag and drop audio or 

video file to a preferred location. Filmora will automatically create a new track for 

the elements dragged to timeline. 

 

 
Add multiple tracks at the same time 
Click the Manage Tracks icon located in the upper left corner of the panel and a 

drop-down menu that lets you add new audio and video tracks or delete a track is 

going to appear on the screen. 
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Click the Open Track Manager option and then you can add up to 99 video and 

audio tracks to a project from the Track Manager window. Moreover, the Placement 

drop-down menu lets you choose how the tracks are arranged. 

 

If you right-click on the section of the timeline below the Manage Tracks icon where 

the information about tracks is displayed you can access each of these options from 

the right-click drop-down menu. 

Under the Manage Tracks menu, you can increase or decrease the size of the tracks 

from the Adjust Track Height submenu. 

Hide & Lock Timeline 
You can click on the Toggle Track Output icon that looks like an eye on a particular 

track if you want the media invisible. The Toggle Track Output option is depicted as 

the sound icon on audio tracks and it enables you to mute an entire track. 

 

The lock icon lets you lock all media on a track. Once you look a track, you will not 

be able to edit, move or change the media files you added to that track. 

Organizing the timeline with markers 
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The Add Marker icon is located in the upper right corner of the timeline and after 

you click on it, a new marker will be added to the same location on the timeline 

where you placed the playhead. 

 

Double-click on the marker you created if you want to gain access to the Marker 

Editor window where you can change the name or the color of the marker or add a 

comment. 

 

If you would like to add a marker to a video clip you just have to make sure that 

the clip is selected and click on the Add Marker icon. Creating notes can be useful 

when working on large projects because you can use them to line up different types 

of media assets. 

 
 

20.6 Change Playback Quality 
For smooth playback during editing, you can change the playback quality. Look at 

the area under the playback window; you’d see a small drop-down button that 

allows you to change the playback quality. 
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You can transition to 1/2, 1/4, 1/8, 1/16, or else stick to full quality. Let me explain if 

this seems confusing; 1/2 means half the playback quality and 1/4 means one-

fourth of the original playback quality. In my experience, changing full playback 

quality to half the playback quality does the job. 

20.7 Group Clips 
In an instance, we want to aggregate a few clips on the timeline to a single place on 

the video clip. For that, we need to group those clips and later on perform certain 

editing depending upon the requirements. 

In this guide, you are going to learn about grouping, ungrouping, and making a cut 

in a group on your timeline. 

How to Group Clips 
Grouping a particular section on the timeline is a fine art but it would take a lot of 

clicks if you are not using the productive method. The art of aggregating a few clips 

into one frame is made easy and wonderful with Filmora video editor. Let’s learn to 

do it in just 1-2 clicks with the help of this wonderful guide. 

 Drag your cursor and select the clips that you want to move on the timeline. 

This method would save your time of selecting and putting each clip manually. 

Alternatively, you can press CTRL key and click all the clips need to be grouped. 

 If you want them to be in a group you need to drag over the group of clips, 
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right-click on the timeline, and select KeepGroup from the options. 

 

 

 

 This way you will be able to group and drag several clips without manually 

picking up each one of them to a certain section on the timeline. 

 
How to ungroup clips with Filmora 
If you want to ungroup the clips you need to right-click on the grouped clips and 

select Ungroup. 

 

Your clips are ungrouped now and you can drag them one by one to any section on 

the dashboard. 
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How to Make a Cut in a Group 
In this part, you will learn to make a cut in the group with simple clicks. 

 Click on the scissor icon as shown in the image and it will highlight the group 

that will be cut. 

 Now a window will come up to ask if you want to ungroup or cut the grouped 

clips. 

 You can checkmark or uncheck the box if you want to see this suggestion in the 

future. 

 There are two cases in this section. If you select Ungroup from the options then 

your clips would move isolate. Ungrouping the clips while cutting is not 

considered as a good practice. 

 You should always select the Keep Group option so that your clips stay together 

even after a cut. 
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Now you have learned how to group, ungroup clips, and also how to make a cut on 

the group of clips. This is very simple and precise where you would find yourself in a 

position to do it more precisely. 

20.8 Mark Clip 
Markers can be used either while you are recording or during the post-production, 

to help you mark the places in the footage where you've made a mistake, where the 

new take starts or to indicate a spot on the timeline where you would like to place a 

particular video clip. In this article, we are going to show you how to utilize markers 

while you're editing videos with Filmora. 

Watching the footage you've captured over and over can be a tiresome process 

that consumes both time and energy, so in order to increase your efficiency during 

the process of capturing and editing videos, you can simply add markers both to the 

timeline and the files on the timeline. 

 

You can click the marker icon to mark any point in time. 

Distinctions Between the Two Types of Markers 

The media markers are the markers you can add directly to the video file. You won't 

be able to see these markers until the video clip is imported into the software's 

video editor and placed on the timeline. 

You can use them to mark a place you're not too happy with, or to highlight the part 

of the video clip that you intend on featuring in the final cut of the video you've 

created with video editing software. 

By doing so you'll save time on going through all the material just to find a few 

seconds of footage that fit perfectly to your video. 



20 Improvement & Troubleshoot 

 170 / 170 

 

The timeline markers, on the other hand, can only be added to a project during the 

post-production period. You can utilize them to highlight the parts of the video clip 

you want to remove from the final version of your video or to mark the spots on the 

timeline where you'd like to switch from one take to another. 

This type of marker is immensely useful if you want to organize the timeline in your 

project better and to know exactly where every clip you want to use in your video is 

located at all times. 

Besides being a highly efficient tool for organizing vast amounts of footage, timeline 

markers can also help you denote the beats in the audio file and then sync the video 

clip perfectly to the beat of the tune you're using as a soundtrack to your video. 


